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 Automated Clinical Evaluation System 

INTRODUCTION 
 

ACES®(1) for Windows is an application package designed to collect, transmit, and report clinical oncology 

research study data. In general, a minimum of 64 megabytes (128 MB is recommended) of random access 

memory (RAM) on a Windows(2) based microcomputer is required to run the software. In addition, ACES® 

has been validated to run on certain local area networks (LANs). Electronic data storage requirements include a 

minimum of 30 megabytes (MB) of hard disk storage, but could easily run to more, depending on the amount 

of data collected. 

 

ACES® for Windows has been designed by Theradex®, in concert with the Investigational Drug Branch of the 

National Cancer Institute. ACES® provides an electronic version of the NCI approved Phase I/II Case Report 

Form. The Case Report Form has been drawn up to include the items which are commonly reported to the 

Clinical Trials Monitoring Service. Both the Case Report Form and the electronic version of the Case Report 

Form contain many items that may not be relevant to each and every Phase I/II study. The Electronic Case 

Report Form (ECRF) is sectionalized into portions of the whole form, so that the investigator may select the 

appropriate portions for any given study. ACES® has been designed in a modular manner in order to easily 

add, delete, or modify procedures, as needed. It is currently tailored to oncologic trials, but can be adapted for 

any therapeutic assessment of disease. 

 

 In addition to the data collection function, the current version provides the facilities to extract data, prepare it 

for transmission to a central database, generate summary reports, validate data at time of entry, and integrate 

data collected on multiple computers to a single location. 

 

ACES® is available through Theradex Systems, Inc., upon request. 

_________ 

 

(1)ACES is a trademark of Theradex Systems, Inc. 

(2)Windows is a trademark of Microsoft Corporation 
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THERADEX® - HISTORY 

 
 

Theradex® was founded in the United States in 1982 by Dr. Robert B. Royds, and remains the only major 

contract research organization in the world specializing primarily in clinical oncologic studies. For over 

fifteen years, we have held the Clinical Trials Monitoring Service Contract for the National Cancer Institute 

in the United States and in that time have gained a wealth of experience in the treatment of cancer and 

allied diseases. 

 

We opened the first of our international subsidaries-Theradex® (Europe) Ltd.-in 1992 as part of our global 

development in life-threatening diseases, particularly cancer. In 1993, we opened Theradex® (Japan)-our 

liaison office in Tokyo. And in 1995, we established Theradex® Australasia Pty. Ltd., based in Sydney. 

 

Because of the Company's close affiliation with the U.S. National Cancer Institute and the EORTC, NDDO 

(New Drug Development Office), SENDO (Southern Europe New Drug Organization), and ECTG (Early 

Clinical Trials Group) in Europe, it is natural that the focus of our worldwide activities continues to be in 

areas of oncology and biologics. 
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THERADEX® - CAPABILITIES 
 

On behalf of both domestic and overseas clients, Theradex® can provide a comprehensive array of 

services. Any portion of these capabilities can be provided to the pharmaceutical industry on an as needed 

basis:  

 

- Prepare all necessary regulatory filings 

- Negotiate resolution of FDA questions 

- Select investigators/study sites 

- Initiate studies 

- Write protocols 

- Design Case Report Forms 

- Monitor single institution or multicenter studies Phases I through IV 

- Collect all required data 

- Assure the numerical validity using statistical techniques 

- Perform statistical analyses 

- Select and administer quality-of-life instruments 

- Write narrative reports 

- Write overall summaries 

- Develop new assessment techniques for drugs and diagnostic/prognostic antibody tests 

- Perform pharmacoeconomic analyses 

- Incorporate automated phone registration using a computerized patient randomization and registration 

system 

 

------------------------------------------------------------------------ 
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CLINICAL TRIALS MONITORING SERVICE (CTMS) 
 

Theradex® has administered the CTMS under contract with the National Cancer Institute (NCI) since 

1982, and is currently operating under the fourth five-year contract. This project has many facets, and 

involves a number of services, some of which are listed below: 

 

1. Perform all ongoing requirements on behalf of the sponsor for Phase I Chemotherapeutic Studies and 

Phase I-II Biological Studies, ensuring:  

 

- Fulfillment of all regulatory requirements  

- Secure and adequate pharmacy procedures  

- Adequacy of institutional review and consent procedures  

- Verification of laboratory competency  

- Thrice yearly verification of individual study data submitted to Theradex® by investigators  

 

2. Evaluation of the compliance of such studies, including:  

 

- Eligibility of all patients  

- Evaluability of all courses of treatment  

- Review the compliance of each investigator  

 

3. Quality Assurance of incoming data from:  

 

- Our remote data entry system, ACES®  

- Case Report Forms submission  

 

4. During the conduct of this contract, the scope has been expanded at the request of the U.S. 

Government/NCI to include:  

 

- Maintenance of all the extramural IL-1/LAK Cell development studies  

- Maintenance of all the intra and extramural IL-2/TIL Cell development studies  

- Institution of new procedures for evaluation of scintigraphic monoclonal antibody techniques which 

visualize minimal malignant disease  

- Development of new procedures for evaluating the effect of Colony Stimulating Factors on the 

diminution of infectious episodes and other indicators of morbidity  

 

5. CTMS also involves:  

 

- Conducting Cancer Center visits to evaluate protocol compliance, response assesments, regulatory issues 

and investigational drug handling by all US Cancer Centers conducting research under an NCI-held IND 

or funded by NCI, generally performed every 3 years  

- Co-monitoring of ~20% of all US Cooperative Oncology Groups site visits  
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SOFTWARE UPDATES 

 
 

Improvements to ACES® will be made available to registered users periodically. These updates are available 

on CDs and sometimes via electronic mail. 
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TECHNICAL SUPPORT 
 

Technical support is available to users by calling Theradex® at (609) 799-7580. Ask the operator to connect 

you to an ACES® Hotline staff member. 
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HARDWARE REQUIREMENTS 
 

Windows® based personal computer 

 

Minimum 233 Mz processor required  

 

30 MB minimum disk space  

 

Properly initialized internal clock/calendar  

 

Local or networked laser printer recommended 

 

128 MB RAM or more recommended 

 

Internet connection 
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SOFTWARE REQUIREMENTS 
 

Windows® operating system    

 

Novell NetWare** or Microsoft Server*** for multi-user installations (Optional) 

 

ACES® for Windows, Automated Clinical Evaluation System  

 

Email program of your choice with a connection to the Internet: any firewall programs present must allow the 

transmission of files with the extension .ALZ as attachments to email messages 

 

  

 

 

 

 

** NetWare and Novell are registered trademarks of Novell, Inc. 

*** Microsoft is a registered trademark of Microsoft Corporation 
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QUICK START PROCEDURE 

 
In order to begin using ACES® for Windows, there are a few basic steps that must be completed, as follows: 

 

1. Install ACES® for Windows. 

2. Run ACES® for Windows from the “Programs” menu. 

3. Add appropriate user names, passwords, and privileges. 

4. Load the Protocol Startup diskette, and, optionally, the Lab Startup diskette. If no Lab Startup disk is 

available, enter the laboratory normal ranges to be used for the study. 

5. Select the Protocol, Patient, and Course for data entry. Subsequently, notice that the Sequence Bar will be 

displayed on the right side of the screen. This indicates which forms need to be completed for the selected 

protocol, patient, and course. 

6. Select a database and perform the necessary entry. When entry for a form is complete for the selected 

patient and course, click on the NEXT DB button on the browse window (or select “Database” from the 

Edit menu) and select the next form for entry. 

7. Weekly, or as needed by the protocol, run the “Transfer to Data Center – Create Compressed file for 

Emailing” procedure to extract a copy of your new or updated data. 

8. Email the resulting file to the appropriate email address at your central data center.  
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INSTALLATION 
 

To install the software, insert Disk 1 into the A: diskette drive and click the START menu. Then, select the 

RUN option. Enter “A:SETUP” into the “Run” dialog box, which will be similar to the following: 

 

 
 

Click the OK button to begin installation. Subsequently, the “Welcome” screen, similar to the figure below, 

will be displayed: 

 

 
 

 

 

Click the “Continue” button to proceed. Subsequently, you will be prompted to enter the installation path. 

Unless your system administrator has a preference, press Enter to accept the default path of  

“C:\ACESWIN”, as shown below: 

 

 
 

 

Click the “Next” button to proceed. The next dialog will prompt for Install Type, as follows: 
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In general, click the “Complete (Recommended)” option. Select “Custom (Select install options)” to run a 

partial install. Click the “Next” button to proceed. The next screen will display installation parameters, 

including the amount of free disk space available on your target drive. If there is not enough free space to 

install the program, you’ll need to cancel and free up some disk space. The screen appears similar to the 

following: 

 

 

 
 

 

Click the “Finish” button to start copying files. You will be prompted to insert successive diskettes until the 

installation is complete. When all files have been copied successfully, a “File Transfer Complete” window 

will be displayed: 
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Click the “OK” button and the system will update your “Programs” menu to include “Aces for Windows” 

as an option. Installation is now complete.  

 

To make it easier to start up ACESWin, it is recommended that you setup a shortcut on your desktop. To do 

this, first start the Windows Explorer by clicking on the Start button, choosing Programs, then choosing 

Windows Explorer (or Windows NT Explorer). On the left side of the Explorer screen, find the drive letter 

that your ACESWin is installed on. If there is a plus sign to the left of the drive icon, click on it so that it 

changes to a minus and thus displays the folders on the drive. One of those folders will be Aceswin. Click 

on the Aceswin folder (not its plus symbol). The right side of the Explorer screen should now display the 

contents of the Aceswin folder. Look for the Aceswin.exe file. When you find it, drag it out to your 

desktop. A shortcut icon is created on your desktop, providing easy access to ACESWin.  
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NETWORK INSTALLATIONS 
 

ACESWin has been tested to operate properly on Novell® and Microsoft® Server networks. In general, 

ACESWin may be installed directly on the server and shortcuts may be setup on the users’ desktops, 

pointing directly to the executable on the network. The Aceswin.ini and Aceswin2.ini files must be copied 

to the Windows or WinNT directories of each user. These files can be found in the ACESWin or 

ACESWin\"study"\BKUP directory, as well as in the Windows or WinNT directory of the installing 

computer. Extra setup requirements are listed below for each network type. 

 

Novell 

 

Each user must have a proper drive mapping to the networked ACESWin directory location.  

 

If more than one person calls on the Help system installed on the network at a time, only the first person to 

bring up Help will be able to access it. To avoid this problem, ACES400.hlp should be copied into the local 

Windows or WinNT directories of all users. 

 

Microsoft Server 

 

Proper network drive mapping is all that is required. If the ACESWin directory is installed on the C: drive 

of a server machine that calls itself ServerA and its C: drive c_drv, then one might map the letter G to this 

drive and use the G: drive in the ACES® configuration file (e.g. the path to the ACES® extract 

directory/folder would be:  G:\ACESWIN\"study"\EXTR). 
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STARTING ACES 
 

 

 

From the “Start” menu, select the “Programs” option, followed by the “ACES” selection from the “ACES 

for Windows” folder. Alternatively, simply double click on the ACESWin shortcut icon on your desktop.  

 

The “Select a Study” dialog will appear, which will be similar to the following: 

 

 

 
 

 

Highlight the desired study and click the OK button to proceed (or double-click the desired study). Your 

installation will have one or more studies displayed, depending on the number of projects in use. After a 

study is selected, you will be prompted for a user name and password. This user name determines the 

privileges you will have in ACES®, directly regulating which features of the program are available for 

your use. 
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USER NAMES, PASSWORDS, AND PRIVILEGES 
 

The default user name is “ACES” and the default password is “TSI”. Enter these values and click the OK 

button to proceed. 

 

 
 

Once you have established your own username, ACES® will keep track of the age of your password. By 

default, passwords expire after 60 days. This expiration time can be adjusted in the Additional 

Configuration Settings window. Whenever your username does expire, the following window appears at 

login: 

 
 

Next, you must enter a new password and confirm it by entering it a second time: 
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The first time you enter ACESWin, if it has not been pre-configured by Theradex® personnel, you will also 

be asked to enter your institution’s site ID and the internet email domain name of your data center 

(Theradex® in most cases). 

 

 
 

 
 

Subsequently, the ACES® for Windows welcome screen will be displayed briefly, or you can press the 

Enter key, or click the mouse to continue.  

 

Help is available by clicking on the “Help” drop-down menu on the toolbar and is styled in the 

standard Windows help system format. 

 

You’ll need to first add the user names and associated passwords, privileges, and purposes that apply to the 

selected study. NOTE: The default user name (ACES) will be automatically deactivated when you log 

out of ACES® if you have added other user names. As you must add at least one user name in order 

to commence with data entry, it is suggested that you add one RW and one DB username at a 

minimum. Details of this are described below. Select the “File” menu and click the “Usernames” option to 

enter this information, as shown below: 
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Once a Username record is added, it may not be deleted or assigned to a different person. The password 

may be changed, and the record may be deactivated or reactivated. No other changes are possible. A 

message reminding you about this always appears whenever inserting records in this file. This preserves the 

integrity of the audit trail. Associated with each user name and password combination is a system access 

privilege. Choose one of read-only (RO), read/write (RW), pick list (PL), database administrator (DB) or 

data center master read/write (MW). A read-only user can view or report data. A read/write user can 

perform the read-only functions, can also enter data for their own site only and can extract and load any 

data in the database. A pick list user can alter or delete the edit checks associated with a particular study. A 

database administrator can’t enter data, but can perform all other functions as well as reconfigure the entire 

system. Therefore, a person with this type of access must be an expert user, since data can become 

permanently damaged if the wrong procedures are used. A data center master read/write user has the same 

privileges as a RW user, as well as being able to modify records that have come in from a remote site.  An 

MW user can also lock or unlock any record. Records generally are locked after they have been audited and 

certified as correct. 

 

You’ll also need to associate a purpose with each user. Choose “Clerk” (data entry), “Review” (data 

manager or study monitor), or “Approve” (investigator). Please create a DB username and PL username 

for your institution, in addition to as many RW usernames as needed. Only a DB user can add or 

deactivate/reactivate other usernames. An RW username is typically the user’s actual first name.  

 

Example: suppose Jane Smith is a datamanager at the Cure Hospital. Jane might setup a RW username for 

herself called JANE, a RW username JOE for research nurse Joe Brown who sometimes helps with data 

entry, and a RO username MARY for Dr. Mary Jones. Jane may never need to alter the database or picklist 

structure of ACESWin, but just in case, she also sets up DB and PL usernames. She might choose JANEDB 

or CUREDB for the DB username, and JANEPL or CUREPL for the PL username. She should designate 

different passwords for all usernames. The passwords should not be easily guessed, but also something that 

she or the appropriate person won’t forget. 

 

A sample entry screen appears below. Note that the password must be entered twice for confirmation, as 

the characters entered cannot be seen. 
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Only DB users may access all Username records and add records of all types. All other users are able to 

change their password and deactivate their own record. Only a DB user can reactivate a currently 

deactivated user. All non-DB  users will see only their own username record. If a non-DB user forgets 

their password, a DB user may login to ACES and assign a new password. No user (DB or not) can see 

existing passwords. 

 

After setting up all needed usernames, it is recommended that you exit and re-enter ACES® before 

proceeding so that you are accessing the program using the correct set of privileges. Remember that 

the default ACES username will be automatically deactivated when you log out of 

ACES® after having created other usernames. 
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INITIATING A NEW STUDY 
 

Most studies that collect data using ACES® are designed by a central data center, which is usually 

Theradex®. As a result of this design, you will have received several pre-configured data files, which were 

loaded during installation of the ACES® software. In addition, a Protocol, and, possibly, a Lab Startup disk 

should have been included in the study startup package. Before you can begin entering data for such a 

study, you’ll need to, at a minimum, initialize the Protocol Abstract and Lab Normals files with the relevant 

information. You can do this in one of two different ways: 

 

1. Load Protocol and Lab Startup diskettes. 

2. Enter the information into the Protocol Abstract, Sequence file and Lab Normals files yourself. To get 

a study started without a startup disk, one must create a Protocol Abstract record and several Sequence 

file records. If you are expecting to receive a Protocol startup disk and do not need to enter the 

Eligibility Checklist form, then you may skip the entry of the eligibility questions in the Protocol 

Abstract record. When you receive the startup disk and load the protocol data, you may then enter the 

Eligibility Checklist form for each onstudy patient. 

 

In general, you will be using option 1, at least for the Protocol Startup. If you’d like to design a new study 

yourself, please refer to the “HOW TO DESIGN A NEW STUDY” section. 

 

To load the information from a Protocol or Lab Startup diskette, insert the diskette into the A: diskette drive 

and select the Startup menu option from the File menu, followed by the Load Startup Data option, as shown 

below: 

 

 
 

You can elect to load a Protocol or Lab Startup diskette. If the central data center has entered an initial set 

of laboratory normal ranges for the new study, you will have both a Protocol and a Lab diskette. In these 

cases, you’ll need to run the procedure multiple times to load the Protocol and all available lab codes on the 
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Lab diskette. Otherwise, you can enter your own set of laboratory normals for each lab being used. The 

Startup screens look similar to the images shown below. Click either the Protocol Abstract or the Lab 

Normals option. The Source Disk is the disk drive letter, usually “A”, where you have inserted the Startup 

diskette. If you have received the startup files via email, copy them into your study’s Startup directory and 

use “C” as the Source Disk. Note that you can change the Startup path specification in the Configuration 

file.  

 

Enter the protocol number printed on the Startup diskette label, if loading a Protocol disk. In general, you 

will always answer “Yes” to load All Tables. For more information on the file choices available if you 

answer “No,” see the section on Makedisk. If you are loading lab normal information, you will also need to 

complete the “Lab Code” field. If there are multiple lab codes on your Lab Startup diskette, you’ll need to 

load each with a separate run of this procedure. Click the Load button when ready to begin loading. Below 

are sample Protocol and Lab Startup screens: 

 

 
 

Note that during 

the Startup 

loading process, 

you will often 

see 

informational 

messages 

displayed. 

These messages 

indicate which 

files have not 

been included 

on the Startup 

diskette. In most 

cases, these 

messages can be ignored since, in general, protocols do not require custom data structures. If you have 

designed your own study using MakeDisk, created unique forms, and subsequently created a Startup disk 

for loading into ACESWin, then the absence of some or all of these configuration files may be relevant. 

 

After loading lab normal information from a Lab Startup diskette, in order to make use of this data you’ll 

need to copy it (using the “Labcodes (Normals)” menu item from the Edit menu) to stamp your site ID on it 

as the SiteID for LabCode. This process is done to avoid overwriting, and then transferring, lab normal 

information entered at another site. If this happens, there is the risk of having multiple sets of normal data 

existing with the same key identifiers.  
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SELECTING A PROTOCOL, PATIENT, AND COURSE 
 

Once a study has been initiated, and has, therefore, a Protocol Abstract, appropriate sequence records, at 

least one set of laboratory normal ranges, a selection of forms and associated fields (this is normally set up 

when ACES® is installed), and appropriate user names profiles, then entry of patient data can begin. The 

first step is to select the protocol, patient identifier, and course (or cycle). From the “Edit” menu, select the 

“Set Protocol/Patient/Course” option, as shown below: 

 

 

 
 
You can enter a protocol and patient, or click the “Lookup” buttons to select from the list in the Protocol 

Abstract and Patient files. Once the patient identifier is entered, the screen will display a list of course 

numbers with associated status codes underneath, corresponding to the protocol selected. Then, enter the 

course number associated with the data to be entered. In the following window, courses 0 (baseline) and 1 

have been started (code = S). Other codes are blank (no entry has been done) or “C” (information for this 

course has been completed). Once all courses have a “C” code (which is a decision made by the data 

manager), then entry for the associated patient should be complete. In the case of studies converted from a 

prior version of ACES® in which course number was not collected in all forms, it is permissible to leave 

the course number as -2. 
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Click either the “Go to DB menu” or “Minimize and Go” buttons to proceed. Pressing Enter is equivalent 

to clicking on “Go to DB menu.” The Set Protocol, Patient, and Course Number window will stay open if 

the “Go to DB menu” button is clicked, while if “Minimize and Go” is chosen, the window will be 

minimized to the bottom left side of your screen. Minimization is suggested if you don’t like a cluttered 

desktop space. If the course number is not -2 and thus 0 or greater, the main ACES® window will now 

include the vertical Sequence Bar on the right side of the screen. This bar will include the form identifier 

for each form requiring entry for the selected protocol, patient, and course. To the right of each identifier 

are two columns. The first will be blank (indicating no entry has been done for the associated form), or will 

have an “S” (indicating data entry has been started, but not completed, for the form). The second column 

will be blank (again no entry), have an “I” (entry has been started but is incomplete), or a “C” (entry is now 

complete for this patient, course, and form). An example is shown below where entry is complete for the 

PT (prior therapy) and  PR (prior radiation) forms, started for the PS (prior surgery),  HM (hematology), 

and BC (blood chemistry) forms, and no entry has been done for the PL (physical lab) or US (urinalysis) 

forms. 
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If your privilege is RW, MW, or RO, the database menu will appear (as shown above), allowing you to 

choose a database to browse. Once the Protocol, Patient, and Course are set, you may choose “Database” 

from the "Edit" menu at any time or click on the “Go to DB menu” button on the Set Protocol, Patient and 

Course Number window to cause the database menu to appear. This allows you to edit more than one form 

at the same time if desired. If you wish to change the protocol, patient or course number, you must close all 

open browse windows first. If your privilege is DB, you may click on the "View!" menu to view the 

database, but you may not edit it. Note that the database menu does not appear if a DB user clicks on 

the “Go to DB menu” or “Minimize and Go” buttons. The View! menu is available for any user as soon 

as a protocol and patient number have been entered; the course number is not necessary for viewing. 

 



23-October-2007 

 

28 

ENTERING PATIENT DATA 

 
From the “Edit” menu, select the “Database” option or click on the “Go to DB menu” button on the Set 

Protocol, Patient and Course Number window to begin entering patient data. [If  “Database” is not 

available (grey instead of black) or the Set Protocol, Patient and Course Number window is not open and 

your privilege is RW, MW, or RO, then see “SELECTING A PROTOCOL, PATIENT, AND COURSE.”] 

Subsequently, a menu of valid forms will be displayed. A sample is shown below: 
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Select the desired form by clicking on it, or alternatively, type the first letter of the desired form until 

selected, then press Enter. (The tab and shift-tab keys may also be used to navigate the menu.) Note that the 

form names are organized alphabetically, and the two character abbreviations are no longer used to select 

the form (as in ACES® DOS). The browse screen for the associated form will be displayed in the first 

window. You have options to insert, flag for deletion or undeletion, change, or copy a record. You may also 

click on the NEXT DB button to close this browse window and bring up the database menu to select the 

next form. You can page up and down through the file also. The “Extr?” column will have a “Y” printed in 

it if the record needs to be extracted for delivery to the data center. This flag is controlled by the software 

and is reset whenever a record is added, changed, or flagged for deletion or undeletion. The “Del” column 

will have a “D” listed if the record is flagged for deletion. ACES® does not erase records that need to be 

deleted, but adds a deletion flag. The purpose for this is to maintain an accurate audit trail, and to assure 

that the central data center (if one is participating in the study) can be electronically notified of all deleted 

records. A sample browse window for the BC (Blood Chemistry Lab) form is shown below: 
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After an existing record is selected for change or flagging, or an insert function selected to add a new 

record, the associated entry form will be displayed. A sample entry form for the blood chemistry lab (BC) 

file would look similar to the following: 

 

 
 
Use the tab key, or your mouse, to proceed forward through the entry fields. Tabbing from the last field on 

an entry screen will automatically display succeeding entry screens, if any. All date fields must be entered 

using the international date format. Note that fields with an associated picklist are designated as such by an 

underlined field label (except for fields in protocol specific forms with a backup picklist - see Define 

Labels and Edit Checks). Pressing the F10 function key will bring up the picklist for the current field. 

After the data entry is complete, click the “OK” button or press the Enter key. Also, notice the 

administrative fields displayed at the bottom of the window. Each record keeps track of the first entered 

date, and the last changed date, time, institution code, and clerk name. Click on the NEXT DB button on 

the browse window to select the next form for data entry. Take note of the Sequence Bar when entering 

data. When you first enter data into a form, the Sequence Bar will display an “I” in the second column, 

indicating entry is started, but incomplete. This will happen automatically. When you have completed entry 

for a particular protocol, patient, form, and course, click the “I” box in the Sequence Bar. This will change 

the “I” to a “C”, indicating that the status of the associated protocol, patient, form, and course is complete. 

 

The BSA (Body Surface Area) is calculated by the program and displayed on the upper right portion of the 

window in the EN and CI forms. The formula used is: 

 

BSA = ((Weight ^ 0.425) * (Height ^ 0.725) * 71.84) / 10000 

(where Weight ^ 0.425 means Weight raised to the 0.425 power) 

 

If the BSA is to be calculated differently for a given study, please enter the value resulting from the 

appropriate formula. 
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In version 4.17 and higher, some new edit checks have been written into the main program code. Please 

note that ACES® will now check the following: 

1. In Off Study, if the Reason is Progression, then the Progression Date must not be missing. 

2. In the Enrollment form, selecting the CTEP Registering Group field will display a window 

reminding the user about the purpose of the field. 

3. Upon insertion in the Enrollment form, the CTEP Registering Institution is filled in by reference 

to a value in the configuration file. 

4. If a grade 5 Adverse Event is entered, ACES® requires the entry of the appropriate Off Study 

record. 

5. The course start dates in Course Assessment and Adverse Events are linked via course number to 

the Course Initiation form. The course start date can only be changed in Course Initiation. 

 

TOXICITY LOOKUPS 

 

The Adverse Events (TX), Baseline Symptoms (BS), Late Adverse Events (LA), and Dose Limiting 

Toxicities (DT) forms all require that the CDUS tox type code be entered. These codes can be looked up in 

the appropriate CTC. Full CTC dictionaries are available within ACES® as reference databases. The 

particular CTC version is specified in the Protocol Abstract record. The version number of the CTC, as 

displayed in the main menu bar, changes based on the contents of the Toxicity Criteria field in the Protocol 

Abstract record. Clicking on “CTC Reference Database!” in the ACES® main menu bar brings up a browse 

window of CTC terms. 

 

 
 

Selecting one of these records will always update the CDUS Tox Type Code. The picklist for the Grade 

field is based on the CDUS Tox Type Code (this picklist can be seen in the Grade column of the Lookup 

Toxicity Type Code window as displayed above). There are two ways that ACES® helps you to maintain 

consistency between the Toxicity (description) field and the CDUS Tox Type Code. First, the associated 

CTEP Toxicity description (second column in above window) is displayed in the upper center of the target 
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form window, above the data entry panel. Second, if the form’s Toxicity field is blank, the CTEP Toxicity 

description will fill it in. Thus, you can use the “CTC Reference Database!” as a picklist for the Toxicity 

field. However, note that the contents of the Toxicity field should always correspond precisely and 

exactly to the source document.  
 

If you are updating an existing record and wish to have the “CTC Reference Database!” fill in the Toxicity 

field for you, simply blank it out before doing the lookup. 
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LOCKING RECORDS 
 

A user with the MW privilege can lock records, thereby protecting them from future updates. A record 

would be locked after it has been audited and certified as valid. If at some future time new data is 

discovered which impacts a locked record, the record may be unlocked (by an MW user only). A record 

flagged for deletion may be locked, but a locked record cannot be flagged for deletion. 

 

To lock a record, an MW user would bring up the appropriate browse window through the Set 

Protocol/Patient/Course window. Note in the below example, there is a new button on the browse window: 

Lock/Unlock. This button appears only for MW users. 

 

 
 

Clicking on the Lock/Unlock button will change the status of the selected record, bringing up the update 

window: 

 

 
 

The browse window now shows an L in the Flag column for the locked record: 
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A locked record may be unlocked by clicking the Lock/Unlock button. If a record flagged for deletion is 

locked, the flag column in the browse window will contain LD: 
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EMAIL ADDRESS DATABASE 
 

In order to use the new compressed data extraction to data center process, allowing you to email your data 

to your data center, you must insert several entries in the email address database. From the Email submenu 

of the File menu, choose Address Database: 

 

 
 

You must have records for your own email address, the data center address, and any other sites to which 

you may choose to send your ACESWin data to. Additionally, if you expect to receive ACESWin data in 

the email format (ALZ) from some other ACES® site, you must designate an onsite data center address. 

Note that your email address can be the designated onsite data center address. Even if you are not the 

official data center for a study, but nonetheless need to receive the ACESWin data from a site that is 

running a joint study with your site, then you must designate an onsite data center address. In the browse 

window above, note that the designated data center addresses are specially highlighted in different colors. 

 

In summary, the minimum requirement is to have two records in this database - your email address and the 

email address of the data center you send your ACESWin data to (aceslink@theradex.com for CTMS 

studies).  Below is a sample update screen: 
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If several people work on the same network copy of ACESWin at your institution, you might have several 

“Site” addresses if more than one person sends data via their email. 
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TESTING ACESLINK 
 

When your configuration options are correctly setup for email transmission and you’ve entered the required 

email addresses in your address database, it is prudent to send a test message to your data center. Choose 

Send Test Message from the ACESLink Email submenu of the File menu: 

 

 
 

 

The Recipient Address Confirmation window 

appears. Your data center address 

(aceslink@theradex.com in the case of 

Theradex®) will be automatically selected. 

Unless instructed otherwise by Theradex® 

personnel, do not select any other addresses, 

just click OK. Next, you will be asked to 

confirm your email address:  
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After choosing your email address, clicking Select and Go, and confirming that you have chosen your 

email, the following window appears: 

 
 

Make sure you are attached to the internet, (but there is no need to be in your email program or any active 

browser) then click the Have ACESWin automatically email the file now button. You will see a window 

like the one below if the test file is successfully sent. If, even after an apparently successful send, you get a 

message from your anti-virus or firewall software indicating an interrupted transmission, you may need to 

have your systems people allow for the sending and receiving of file attachments with an extension of ALZ 

through your internet connection. 
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EXTRACTING DATA 

 
Weekly, or as needed by the protocol, you can run the data extraction process. This process will scan 

through the database and make a copy of all data selected, for a variety of purposes. Data can be extracted 

to send to a central data center (“Transfer to Data Center”), to send to another ACES® installation 

(“Transfer to ACESWin”), or to archive it (“Archive”). The data extracted to be sent to the Data Center 

may be stored in one of two different formats. In the Transfer to Data Center submenu, only one format 

will be available, dependent upon a setting in the configuration file. See the help page on setting 

Configuration Options to change your ACESWin data center extract format from the traditional XTR to the 

new compressed ALZ format. Note that in order to extract in this new ALZ format and email the resulting 

file to Theradex®, you must also enter some email addresses in the Address database. If you choose to 

create the traditional XTR files, you must send this data to Theradex® on a floppy disk.  

 

Overview of email transmission 
 

If correctly configured, and you choose the ALZ extraction format, ACES® will attempt to transmit your 

data to Theradex® via a direct SMTP internet connection. ACES® will send your data as an attachment to 

an email message sent from within your ACES® program. If there is some error while connecting to the 

SMTP server or while attempting to send the message (with the data attached), an error will be reported in 

the ACES® environment and the message will not be sent. If that is the case, then the data may be sent 

"manually" via your normal email program. If the message is correctly sent through ACES®, but then 

rejected at the receiving end for some reason, it gets returned to your email address (which is specified in 

the email database in ACES®) in your normal email program. ACES® cannot receive any email - it can 

only send it. And it may only send email with ACES® data attached to it to email addresses that are 

specified in the ACES® email address database. In the vast majority of cases, you will be sending the data 

to one email address only: aceslink@theradex.com. As there are some multi-site studies in which data from 

several sites needs to be collected at a single coordinating site as well as sent to Theradex®, ACES® was 

designed so that up to ten email addresses could be sent the same message with data attached. In practice, a 

satellite site would be sending their data to just Theradex® and one coordinating site, and possibly to a 

Theradex® technical support person for verification. Please note that ACES® cannot be used to distribute 

SPAM. Additionally, only ACES® data in the form of a password protected and compressed ALZ file is 

attached to messages sent from ACES®. Messages cannot be sent without this data and no other 

attachments can be made. The body of the email message can optionally include up to 512 characters of 

text if you need to communicate something to Theradex®. 

 

In version 4.17 and higher, ACES® uses 256 bit encryption for the transmission. 

 

 

Transfer to Data Center – ALZ compressed format 

Transfer to Data Center – XTR traditional format 

Transfer to ACESWin & Archiving data 
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Transfer to Data Center – ALZ compressed format 
 

 
 

Once you have made the proper entries in the configuration file and the email address database, and you 

choose to extract for transfer to Data Center, creating the compressed file for emailing, you will be asked to 

specify all email addresses that you plan to send the resulting ALZ file to: 
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Note that your data center is already specified.  Specify any additional addresses, then click the OK button. 

If you have kept the default SMTP IP address for Theradex® in the configuration file, then besides sending 

the data to aceslink@theradex.com, you could also send the data to someone else at Theradex® (like 

pclark@theradex.com), but not someone at another institution. More generally, if you select an address that 

is not in the domain of your data center and the SMTP IP address that you are using in the Configuration 

file is your data center’s, you will be warned that you may not send the data to that site given your current 

setup. 

 

 
 

Next, you will be asked to select your email address from the email database. A receipt email containing a 

unique receipt code number will be sent to this email address from your data center confirming the 

successful arrival of your extraction file (ALZ).  
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You will be asked to confirm that you have selected your email address: 

 

 
 

The traditional extract filter window appears next. 
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You may enter values into each of the displayed fields, in order to selectively filter your extract data. For 

example, to include all protocol 333-3333 data, enter that protocol (or run the Lookup function or press a 

mapped function key, if set in the Configuration Options menu, to select it). If you leave all other items in 

their default condition, then no other filters will be applied to the extraction data set. This would be the 

most common method of running a “Transfer to Data Center” since the system keeps track of which 

records have been added, changed, or flagged for deletion or undeletion since the last extraction. After a 

“Transfer to Data Center” extraction, each extracted record is flagged as “has been extracted”, so that it will 

not need to be extracted again for this purpose. If for any reason a previously extracted record needs to be 

re-extracted, then entering a “Start Date” value equal to a date on or before the target record was last 

changed will force the system to re-extract all records added or modified on or after that date. Alternatively, 

if you just want to re-extract a few records, you can use the “Database” menu to edit each record, and save 

it with no changes. This will force the system to think these records need to be extracted, so that when the 

next “Transfer to Data Center” is run, those records will also be included. 

 

Also note the “Destination” location specified at the top of the screen. This indicates the disk drive and 

directory where the ALZ file will be placed following the extract procedure. To change this location, run 

the Configuration Options procedure from the “File” menu. 

 

The Locked Records Only filter will only be available for MW users. Using this filter will result in the 

extraction of locked records only that meet any other filter criteria as well. 

 

If you previously sent an ALZ file to your data center, received the receipt email, used the receipt number 

from the email to acknowledge the transmission in the ACESLink Log, then chose to run an extraction to 

create a new ALZ file, the extraction would start at this point and the below window would not appear. If 

you have not acknowledged the previous transmission in the ACESLink Log, you will have the opportunity 

to acknowledge it now in a window similar to the one shown below: 
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As requested in the window, please enter the three digit receipt code (number) that came in the receipt 

email. The receipt number is listed in both the subject line and in the first line of text in the body of the 

email.  If you did not receive a receipt email, then your data center either did not receive your last ALZ file 

or has been negligent in sending the appropriate receipt for perhaps technical reasons. In either case, if you 

leave the receipt number field blank and click on the Continue button, the old ALZ file will be unzipped 

and your new extract data will be appended to the end of the old extract files. A new ALZ file will get 

created – the older one has now been absorbed into it. This is recorded in the ACESLink log and helps to 

guarantee that data will not get lost. After clicking Continue, ACESWin will run through all the forms, 

extracting the specified data. When the extraction is complete, the following alert window appears: 
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Under normal circumstances, please click on the default button (or press Enter), “Have ACESWin 

automatically email the file now.” You may choose to include a brief message to Theradex® personnel by 

clicking on the Yes button in the following window: 

 

 
 

If you do choose to include a message, the following window is displayed, in which you may enter your 

message: 
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Finally, you are asked to confirm that you are indeed connected to the Internet: 

 

 
 

When the transmission commences, you will note Internet information being displayed in the Extraction 

Complete window just above the buttons at the bottom: 
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When the transmission is complete, a small confirmation window will be displayed over top of the 

Extraction Complete window: 
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Make sure to read the Acknowledging the Transmission. 

 

Acknowledging the Transmission 

 

It is crucial that each transmission be acknowledged. The data center will email you a receipt message, 

containing a three digit receipt code number. Ideally, when you receive the receipt, you will immediately 

acknowledge the transmission within ACES®. This is discussed in detail in the section on the ACESLink 

Log. If you are not inclined to acknowledge the transmission immediately, you can do so later in the 

ACESLink Log or when you start your next extraction (as described above). In either case, you might want 

to print the email message containing the receipt code number. 
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Transfer to Data Center – XTR traditional format 
 

When the Configurations file has been set to XTR extract format for transfers to the data center, choosing 

to run this process  in the Extract menu will bring the following filter window up: 

 
As in the ALZ style of extract, you may enter values into each of the displayed fields, in order to 

selectively filter your extract data. For example, to include all protocol 333-3333 data, enter that protocol 

(or run the Lookup function or press a mapped function key, if set in the Configuration Options menu, to 

select it). If you leave all other items in their default condition, then no other filters will be applied to the 

extraction data set. This would be the most common method of running a “Transfer to Data Center” since 

the system keeps track of which records have been added, changed, or flagged for deletion or undeletion 

since the last extraction. After a “Transfer to Data Center” extraction, each extracted record is flagged as 

“has been extracted”, so that it will not need to be extracted again for this purpose. If for any reason a 

previously extracted record needs to be re-extracted, then entering a “Start Date” value equal to a date on or 

before the target record was last changed will force the system to re-extract all records added or modified 

on or after that date. Alternatively, if you just want to re-extract a few records, you can use the “Database” 

menu to edit each record, and save it with no changes. This will force the system to think these records 

need to be extracted, so that when the next “Transfer to Data Center” is run, those records will also be 

included. 
 

Also note the “Destination” location specified at the top of the screen. This indicates the disk drive and 

directory where the XTR files will be placed following the extract procedure. To change this location, run 

the Configuration Options procedure from the “File” menu. 
 

The Locked Records Only filter will only be available for MW users. Using this filter will result in the 

extraction of locked records only that meet any other filter criteria as well. 
 

Any XTR files that previously existed in your destination location will be appended onto. No data is 

overwritten. 
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Transfer to ACESWin & Archiving data 
 

The same general filter screen is displayed when choosing to transfer data to another ACESWin or archive 

data. Extract files with an XFR extension get created in Exch directory by default or whereever you  have 

specified in the Configuration file if you choose Transfer to ACESWin. Extract files with an ARC 

extension are created in the Arc directory by default or whereever you have specified in the Configuration 

file if you choose Archive. 

 

 
 

Note that for the “Transfer to ACESWin” or “Archive” functions, the system does not set the extraction 

flag and depends solely on the filter parameters you enter to decide which records should be extracted. 

Therefore, if you enter only protocol 333-3333 and run either of these procedures, then all 333-3333 data 

will be processed. If you enter a patient identifier, then all data for that patient will be extracted, etc. In 

addition, after the “Archive” option creates the ARC files containing the extracted data, the same data is 

then deleted from the live database. Please use this option carefully. In the event that you do run it in error, 

you can use the “Load” function to re-load the archived data. 

 

The Locked Records Only filter will only be available for MW users. Using this filter will result in the 

extraction or archiving of locked records only that meet any other filter criteria as well. 
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ACESLINK EMAIL LOG 
 

ACESWin keeps track of ALZ files sent and receipts received back from the data center in the ACESLink 

Email log. Transmitted ALZ files may be acknowledged here using the three digit receipt code number that 

is emailed from your data center. This log may be viewed and printed by choosing View ACESLink Log 

from the Email submenu of the File menu: 

 

 
 

The fifth column contains the direction, which is instructive in understanding several of the other columns 

of data. If an entry has a direction of “To”, then the email address is the address the ALZ file was sent to. If 

an entry has a direction of “From”, then the email address is the address the ALZ file came from. The 

temporal fields will have different reference frames dependent upon the direction. The date and time are the 

moment when the ALZ was created, and the date acknowledged is the day when the receipt was sent from 

the data center. Of course, your site might be a data center. If you receive an ALZ file from another site and 

your site IS NOT the data center, you must specify this when you load the ALZ file. Accordingly, you will 

not be required to send a receipt and the log will not record a date in the date acknowledged field. This field 

will remain 00 UNK 0000 since your ACESWin will not know when the actual data center receives and 

acknowledges the ALZ. 

 

To acknowledge a successful transmission, navigate to the record for the appropriate ALZ file (most likely 

the one just transmitted) - make sure the highlight bar is on that record. Enter the three digit receipt number 

as listed in the receipt email (received from your data center) in the yellow field labelled 'Enter code for 

selected ALZ:', then click the 'Acknowledge with 3 digit receipt code' button, and you are done. Once the 

ALZ transmission has been acknowledged in your ACESLink log, there is no need to save the receipt 

email. 
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You will get a small window acknowledging your action: 

 

 
 

After clicking the OK button, you will note that the Acknowledged Date has been set in the sixth column 

and the status flag has changed from N to R in the last column. 
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LOADING COMPRESSED ACESWIN (ALZ) DATA 
 

You may receive an email from another ACES® for Windows site with an ALZ file attached to it, 

containing ACESWin data.  

• If your site is serving as the data center, this is expected. Understand that if you are truly the data 

center, then you have designed the study, including the protocol abstract, sequence file, special 

labcodes, and any custom forms, and then distributed this startup data to all remote sites.  

• Your site may also be coordinating a study for which some other site is the data center (typically 

Theradex®). If this is the case, please see the section below that addresses special issues.  

In either case, the default location for ALZ files to be placed is the DataCent directory. You may of course 

alter this location in the Configuration file.  

 

ACESWin will not allow a RW user to update a record that has been loaded in from another institution. 

You will be able to look at the data, print, extract and export it. Only a user with MW (Master Read/Write) 

privilege can change a record that was originally entered at another institution. Be very careful about 

changing any record that originated at another site. 

 

Choosing “Remote site ACESWin data (ALZ file)” from the Load menu typically brings up a window 

similar to the following: 

 

 
 

If you are a coordinating site but not a data center, you must be sure to have certain supporting files 

(supplied by the remote site) loaded before loading the clinical data received via email. You should read the 

section below (for Data Centers) to get information on the bounce mechanism, but also, please click here to 

get details on the required preload tasks. 
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YOUR SITE IS THE DATA CENTER 
 

Be sure to click the check box at the bottom of the “Load remote site ACESWin data (ALZ file)” window 

indicating that your site is the one and only data center for the study data about to be loaded.  

 

 
 

When loading any data (except Archived), ACESWin will always ask what it should do when a record 

already exists. You may choose to bounce new data for all existing records, or just those records which 

have been locked. A record can be locked only by an MW user. Sometimes it is useful to bounce data for 

all existing records, just to see what is coming in. Bounced data can always be reloaded. 

 

 
 

When the process is completed, if any records were bounced, the following window appears: 

 

 
 

Whenever you choose to print the report, the new values that were bounced will be bolded and appear 

under the current values. In the sample below, three values are different in the new record that bounced, 

values for Creatinine, Sodium, and Potassium. 
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Finally, a notice window will appear, reminding you to email a receipt with a specific receipt code number 

to the email address from which the loaded ALZ file came from. Such a window is shown below as an 

example: 

 

 
 

 Clicking Yes will initiate an automatic transmission of the receipt email. Clicking No will bring up another 

window that asks you to manually email the receipt number to the appropriate address: 

 

 
 

If you decide to use the automatic receipt send from within ACES®, you will need to confirm your email 

address: 
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No feedback will be given from ACES® regarding the progress of the transmission other than the yellow 

box and text shown in the Sender Address Confirmation window. Depending on your internet connection, 

the transmission may be fairly instantaneous or take some 10 to 15 seconds or more. 

 

 
 

If the transmission is successful, a small window stating that “Email sent successfully!” will be displayed.  
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If the transmission is not successful, a window with a report of the error will appear, similar to: 

 

 
 

You will be asked to send the email manually: 

 

 
 

YOU ARE THE COORDINATING SITE BUT NOT THE DATA CENTER 
 

You must receive some additional files from the other ACES® for Windows site. These files must be 

loaded in your ACESWin prior to loading the ALZ file. Ask the other site to follow these steps: 

1. Extract for Transfer to ACESWin. 

2. In the extraction window, choose N for the All Forms? field and press Tab. Turn off the Patient file by 

clicking on the check mark and click on the All button for Lab Normals. 

3. Click OK on the extraction filter window, then click Close on the Select form for Processing window. 

4. When the extraction is done, again choose Extract for Transfer to ACESWin. 

5. Enter the Protocol number that needs to be extracted in the Protocol filter field. Again enter N for All 

Forms?, then click on the Protocol Abstract (there should be a check mark next to both Protocol 

Abstract and Patient File). 

6. Again, click OK on the extraction filter window, then click Close on the Select form for Processing 

window. 

7. The files Startseq.tps, Pa.xfr, Pat.xfr, and NR.xtr, found in the Exch directory (typically 

c:\aceswin\std4\exch), should be emailed to you as file attachments. 

When you receive these files, they should be placed in your Exch directory (again, typically 

c:\aceswin\std4\exch). Make sure that no other files are present in your Exch directory. You should then 

choose “ACESWin Data (XFR files)…” from the Load menu and click OK on the Load window to 
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commence loading. Only after this process is completed should you choose “Remote site ACESWin data 

(ALZ file)” from the Load menu. DO NOT click on the check box at the bottom of the Load window 

indicating that you are the one and only data center. Confirm that you have placed the ALZ file in the 

proper place by noting the Source path at the top of the window. Click OK to load the ALZ file. 
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LOADING ACESWIN (XFR) OR ARCHIVED (ARC) DATA 

 
If you, or another ACES® for Windows installation, has run a “Transfer to ACESWin” or an “Archive” 

procedure, then that data can be loaded, or re-loaded. Select the “Load” menu, followed by the “ACESWin 

Data” or “Archived ACESWin Data” options, depending on the method used to extract the source data. A 

window similar to the following will be displayed: 

 

 
 

In general you will leave all filters in the default condition (missing) to load all data. Alternatively, you 

might choose to load only a single protocol, patient, or form. Note that when you load archived data, the 

system will not overwrite existing records. If you need to change the default source, select “Configuration 

Options” from the “File” menu. The remainder of this section applies only to ACESWin (XFR) data only, 

not Archived (ARC) data. 

 

When loading any data (except Archived), ACESWin will always ask what it should do when a record 

already exists. You may choose to bounce new data for all existing records, or just those records which 

have been locked. A record can be locked only by an MW user. Sometimes it is useful to bounce data for 

all existing records, just to see what is coming in. Bounced data can always be reloaded. 
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When the process is completed, if any records were bounced, the following window appears: 

 

 
 

Whenever you choose to print the report, the new values that were bounced will be bolded and appear 

under the current values. In the sample below, three values are different in the new record that bounced, 

values for Creatinine, Sodium, and Potassium. 

 

 
 

 

IMPORT FOR REEXTRACTION (AND LOADING DATA FROM OTHER SYSTEMS) 
 

When Import for Reextraction is chosen from the Load menu, ACESWin will load XFR files in such a way 

that guarantees the data within will be forwarded onto your data center (Theradex®) during your next 

normal extraction and transmission. The XFR files may be from another ACESWin or from some other 

database system. 

 

If you are generating XFR files from your own non-ACES® system, these ASCII files need to be formatted 

as if they had been extracted from ACESWin. Run the Extract/Load File Structure report to get a printout 

of this format. If your system keeps track of the last changed time and you wish to load this into ACESWin 

with your data, make sure that it is formatted as hhmmss. Thus, 5:30:23 PM would be stored as 173023. If 

you do not keep track of the last changed time, set it to 0 in the ASCII file. Some administrative dates and 
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times set to 0 or blank will be re-assigned the current date and time by the Load procedure, but the last 

extracted date will be set to 0 to force the re-extraction. Blank dataclerk and institution fields will be re-

assigned the current dataclerk and institution code. Lab files will receive special treatment: 

 

1. Blank labtimes will be set to -2. 

2. Blank labcodes will be set to 5000. 

3. Blank SiteID for Labcodes will be set to your site’s ID. 

4. Any lab value fields that are blank will be set to -2. 

 

 

If possible, all fields should be left justified, though the Load procedure does left justify the key fields. The 

DelFlag can have only two values: ‘D’ or a blank. 

 

When the files are ready, they should be stored in the transfer/load folder (by default, Aceswin\Std4\Exch), 

then Import for ReExtraction should be chosen from the Load menu: 

 

 
 

The windows and choices that follow this screen are the same as those presented in the previous section on 

the standard loading of ACESWin  (XFR) and archived (ARC) data files. 
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LOADING BOUNCED DATA 
 

If after analysis of a bounce log, it may be determined that some or all of the associated bounced data 

should be loaded. If only some of the bounced data should be loaded, then certain precautions need be 

taken. Existing records that should not be updated by the bounced data should be locked. Records that 

should be updated must be unlocked (if not already so). To lock or unlock a record, you must be logged 

into ACESWin as an MW user.  

 

When all is ready, choose Bounced Data… from the Load menu: 

 

 
 

In the Specify Bounce Log window, you must choose the particular bounced data that you would like to 

load. This may be done by double clicking on the appropriate bounce log, or by entering the Bounce Date 

and Time as listed on the hard copy print out of the bounce log containing the data to be reloaded. Note that 

the log creation time as listed in the browse list does not correspond precisely with the Bounce Time as 

printed in the hard copy report. The actual Bounce Time is embedded in the Bounce log filename. The 

minutes and seconds are easily read from the filename. In the above example, the first Bounce log in the list 

above has a Bounce Time of 1:33:59 PM (when data were first added to it), while the file was created at 

1:34:32 PM (when the file was saved after the last data were added). There is however, no need to analyze 

the filename; simply refer to the date and time listed on each page of the printed Bounce log or double click 

on the entry based on your memory. 

 

Next, you will again be asked to specify how ACESWin should deal with updates to existing records: 
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You will next be asked if you are the one and only data center for this data. If you are the data center (and 

therefore Theradex® is NOT), then the extract date of each loaded record is reset, allowing for easy re-

extraction to send to a sponsor. If you are not the data center, the extract date is preserved, therefore 

keeping the record from being extracted during future standard extractions (in which no start date is 

utilized). The data center expects to receive data entered at a specific site from that site, not from another 

site which happens to be sharing data with the site of origin. 

 

 
 

If all records are loaded and none of them bounce, you’re done. If some records bounced again due to 

locked records, you will have the opportunity to print the associated bounce log. 
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GLOBAL FLAGGING OF DATA 

 
Global flagging of data is restricted to those users with DB privilege. In the event that you need to flag a 

large number of related records for deletion or undeletion, you may do so by selecting the “Flag” menu 

item, as follows: 

 

 

 
 

Records may be flagged for deletion, but not physically erased. You can elect to process a whole protocol, 

an entire form for a particular protocol, an entire patient, or an entire form for a single patient. Otherwise, if 

you need to be more selective about which records are flagged, you’ll need to use the “Database” option to 

flag each record separately. If you enter “N” in response to the “All Forms” prompt, a list of available 

forms will be displayed where you can select which to include in the flagging process. Simply click on each 

form you’d like processed, one at a time. The window would be similar to the following: 
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Special EX and LX considerations 
 

The EX (Lab Extra) and LX  (Literal Extra) forms are protocol specific, and each may have up to 100 

different associated panels or screens. For details on adding a new form, see Adding new EX or LX forms. 

If multiple panels are required, see Multiple Lab/Literal Extra Forms In A Given Protocol. 

  

Adding new EX or LX forms 
 

Users with DB privilege may add additional EX and/or LX forms without having to add a typefile record. 

For these forms only, follow these instructions: 

1. Insert a new or modify an existing Labels file record. Note that by updating an existing Labels record 

and changing the Protocol and/or the Panel fields will actually add a new record and leave the existing 

record unchanged. The structure of EX and LX must remain identical to the sample Labels records 

(protocol 333-3333). The one exception to this rule involves the number of fields. EX has room for up 

to 25 tests (along with the required “Significant?” flag fields). LX has room for up to 10 tests. In either 

case, your new form need not have the maximum number of tests. 

2. Add Length file records for each label in the new Labels file record. This may be done by clicking on 

the “Update From Labels” button in the Length file Browse window. Length records will be added for 

each new label. You will have to update each of these new Length records with the proper lengths. See 

Length records for sample EX and LX labels for proper lengths. 

3. A new labcode and associated units will need to be added to the Ranges file for a new EX form. 

 

Multiple Lab/Literal Extra Forms In A Given Protocol 
 

Multiple Lab Extra or Literal Extra records in the Labels file for a given protocol are differentiated by a 

panel number. Only one record will exist in the Typefile for EX and another for LX for each protocol. 

When updating this record, ACES® will ask for a panel number, used to display the associated labels. 

Since you have several sets of labels (each set associated with a panel number), it is important to pick the 

set with the greatest number. For example, suppose that in protocol 111-1111, panel 0 has 10 labels for 

non-key fields (SiteID for Labcode, Lab Code, Test 1, Significant?, Test 2, Significant?, Test 3, 

Significant?, Test 4, Significant?), and panel 1 has 14 labels for non-key fields (SiteID for Labcode, Lab 

Code, Test a, Significant?, Test b, Significant?, Test c, Significant?, Test d, Significant?, Test e, 

Significant?, Test f, Significant?). 
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ENTERING A NEW SET OF LABORATORY NORMAL RANGES 

 
Lab normals need to be entered into the database when a new study starts, during the course of a study if a 

new lab is used, or when an existing lab updates any of its normal ranges. If you have received a Lab 

Startup diskette from the central data center, you may use that to load the ranges. However, after loading 

norms from a Startup diskette, you'll need to copy them so that your site ID is stamped on them, thus 

enabling you to make use of them for your own data entry. To enter them yourself, select the “Edit” menu, 

followed by the “Labcodes (Normals)” option. A sample browse window is shown below: 

 

 

 
 

 

Click the “Insert” button to add a new record, or the “Change” button to alter an existing record. Click 

“Copy” to copy an existing set of normals to a new set. This option is useful if a new lab has ranges that are 

similar to an existing lab, or to make use of a set of normals that have been loaded from a Lab Startup 

diskette. Click the “Flag/Unflag” button to flag a record for deletion, or to undelete it. Due to the necessity 

of keeping an audit trail, and to maintain the integrity of older data, lab records cannot be erased, only 

flagged for deletion. 

 

The first part of the entry form will display the overall characteristics of the lab, including lab name, 

gender, and code. The protocol number should only be entered for EX and any other lab form that is 

protocol specific. To set up a protocol specific form, see Defining Protocol Specific Lab Forms. All generic 

forms and their supporting structures utilize a protocol number of 00000000. The Filter Group field should 

be kept at 0 unless the patients are divided into two or more populations (like smokers vs non-smokers) 

having different lab norms. This field corresponds to the Filter Group field in the EN (Enrollment) form. 

The Generic Norms checkbox should only be checked when the laboratory's actual norms are not entered, 

but instead general ranges are used. This allows for capture of the laboratory's name in each actual form, as 

well as general edit checking, without having to enter and/or keep updated the actual lab normals. 
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Double click (or highlight and click on the Change button) the lab test for which you wish to enter or 

update lab normals. You may enter up to five sets of age ranges and corresponding normals for each lab 

test. You will need to specify the units for the lab test. The units entered must be on the list of acceptable 

units. See Laboratory Units. The entry form will be similar to the following: 
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LABORATORY UNITS 

 
To aid in edit checking, ACES® keeps a database of the list of valid units that can be associated with each 

laboratory test. To modify this list, select the “Edit” menu item followed by the “Lab Units” option. 

Double-click (or highlight and click "Change") the selected lab form from the browse screen, which 

appears similar to the following: 
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Each lab test is displayed on a button with a small number to the left of it. The number indicates the 

sequence of the lab test on the actual form screen. To the right of each lab test button may be a green check 

mark. A check indicates that at least one unit has been stored for the associated lab test.  

 

 
 

Clicking on each lab test button allows you to 

enter/update units and other associated data. For 

example, if BUN was selected to be altered from the 

Blood Chemistry file, the subsequent entry form would 

be similar to: 

 

 

 

The order field enables you to reset the tabbing order of 

lab forms, but not the data structure of the form. Thus, 

you may customize the tabbing order of the lab tests 

within each lab form to match the hard copy source 

documents you are entering data from. The Leeway 

percentage allows you to regulate how far above or 

below a normal the patients values must go before an 

"Out of Range" warning window appears. The default 

value is 20%. You may enter up to five different valid 

units for each lab test. You may also associate a 

conversion factor to some “standard” unit that is used by 

your institution, or study. This conversion factor is used 

in order to merge laboratory results across different units. 
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LABORATORY NORMAL EXTRACT/EXPORT FILE STRUCTURE 
 

Below is the general file structure generated when the Laboratory Normal Ranges file is extracted or 

exported. Note that there are several arrays in this structure. The actual normals are stored in a two 

dimensional array along with associated age ranges. The format of the array is 30 by 5 by 4. Each storage 

location is nine characters long, thus 30*5*4 = 600 nine character strings. Here is the logic behind the 

structure: 

- maximum of 30 possible lab tests in each lab form 

- maximum of 5 possible age ranges for each lab test 

- for each age range, there are four values 

 - Minimum age 

 - Maximum age 

 - Minimum normal limit 

 - Maximum normal limit 

 

The first 5*4*9 = 180 characters will be for the first lab test in the lab form that the lab norm (labcode) is 

for. In most cases, there will only be one age range for each lab test. This means that the first 4*9 = 36 

characters of each "180 character block" will contain the min age, max age, min norm, and max norm, and 

the other 144 characters will be blank. When you use the export process and choose a delimiter, each field 

of course will be sectioned off with the delimiter. 

 

FileID                      STRING(3) !This will always be ‘RA ‘ 

Version                     STRING(4) !ACESWin version 

EXDTE                       STRING(8)  !Date of last extraction 

Clerk                       STRING(8)  !Data entry username 

EDTE                        STRING(8)  !First entered date 

CDTE                        STRING(8)  !Last changed date 

CTime                       STRING(7)  !Unused in Ranges 

DelFlag                     STRING(1)  !Deactivates record if set to 'D' 

DelDate                     STRING(8)  !Date deleted status last changes 

Protocol                    STRING(12)  !Protocol number for protocol specific ranges 

Institution                 STRING(8)  !Site where record was last changed 

RecType                     STRING(3)  !Lab form ID (e.g., HM = Hematology) 

LabSite                     STRING(8)  !Originating institution of labcode 

LabCode                     STRING(4)  !Numeric code for laboratory 

Panel                       STRING(2)  !A particular Lab Extra screen 

GenFil                      STRING(1)  !Generic filter from the EN (Enrollment) form 

Sex                         STRING(1)  !Sex of labcode (X, F, or M) 

EffectiveDate               STRING(8)  !Date lab code is first effective 

GenericLabNorms         STRING(1) 

LabName                    STRING(32)  !Name of the laboratory 

For T = 1 to 30  !30 possible tests 

  For R = 1 to 5   !Each test has 5 age ranges, some unused 

    MinimumAge(T,R) STRING(9) 

    MaximumAge(T,R) STRING(9) 

    MinNormal(T,R) STRING(9) 

    MaxNormal(T,R) STRING(9) 

  End 

End 

For T = 1 to 30  !30 possible tests 

  Units(T)                  STRING(10)  !Chosen units for test 

End 

For T = 1 to 30  !30 possible tests 

  Factor(T)                 STRING(8)   !Conversion factor to default unit 

End 

Send                        STRING(1)   !Marks record for sending 
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EXPORT DATA 
 

To export data from ACES® for Windows into a standard ASCII file format, you select the Export option 

from the main File menu. You should verify in the Configuration Options item from the File menu that the 

target location for your export files is correct. The “Remote Transfer and Load” specification will be used 

as the export location. The Export option is selected in the example below: 

 

 
 

Subsequently, the export filter window is displayed which allows you to select which subset of data you’d 

like exported. You may restrict output based on Protocol, Patient identifier, Course, Protocol Type, Form 

Type, and Start Date. Start Date refers to the latest date that a form was entered or changed. For example, if 

you’d like to include all data entered or changed since January 1, 1998, you would enter 01 JAN 1998 into 

the Start Date field. If you specify “N” for “All Forms?” you will, upon completion of the filter window, be 

able to select which forms to export. 

 

In addition, you’ll need to specify how you’d like the output ASCII file to be formatted. If you’d like the 

fields separated by a character, enter that character (e.g. a comma) into the Delimiter field. If you do enter a 

value here, then the first record in each output data file will contain the field labels for each field extracted. 

This option often simplifies the process of importing the data into other programs. If you do not specify a 

delimiter, then a space will separate fields and no field labels will be included in the first record. 

 

You may also elect to include or exclude lab normal ranges, deleted records and administrative fields. Due 

to audit trail logic, all records entered are saved in the database. Deleted records are flagged with a “D” in 

the delete flag field. Administrative fields include information for the first entered date, last changed date, 

last changed time, last entry clerk user identifier, institution code, last deletion date, delete flag, last 

extracted date, overall last changed date and overall last changed time. 
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Finally, you may decide whether to enclose literal fields in quotes. This option will be dependent on the 

target software that will be importing your data. If you select this, the field labels will also be enclosed in 

quotes. 

 

Following the filter selections, if you have entered a “N” to export “All Forms” then a form selection 

screen will be displayed, similar to the window as displayed below. Click the desired form.  

 

 

 

 

 

 
 

 

At this point the export process will begin and informational messages will be displayed as each form 

selected is processed. The target location for the export files is identified in the Configuration Options item 

located in the File menu. 
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HOW TO DESIGN A NEW STUDY 

 
When designing a new study containing non-standard forms, it is recommended that the study’s structural 

details be kept isolated from test data. 

• Setup a new subdirectory of ACESWin for the new study.  

• The subdirectory should then be filled with the following ten subdirectories: Data, Atrl, Arc, Exch, 

Extr, Datacent, Bounce, Startup, Bkup, and Bknorms. All of these should be empty except for the Data 

directory. 

• The following files should be copied into the Data subdirectory from another Data directory (an 

existing study or by installing fresh data files from the installation diskettes into a temporary 

directory): EXVL.TPS, HOT.TPS, IDFORM.TPS, DC.TPS, KEYPOS.TPS, LABELS.TPS, 

LENGTH.TPS, MASTER.TPS, TYPEFILE.TPS, EXCEPT.TPS, DCDOMAIN.TPS, ACESVER.TPS, 

CONFIG2.TPS, INSTITUT.TPS (this file contains your institution code – if you don’t copy this file 

over, the new user will have the opportunity to enter the same or a different institution code), 

EMAIL.TPS (this file contains the email addresses for transmitting ACES data – it may need 

updating), and possibly LIST.TPS (copy this file in only if you want to use the picklists from some 

existing study). All subdirectories of a currently in use Data directory should also be copied into the 

new Data directory – these subdirectories hold various versions of the CTC reference database. 

• Enter Protocol Abstract record, including the eligibility checklist questions. Be sure to choose the 

relevant CTC database in the Toxicity Criteria field. 

• Design database structure in ACESWin as described in the pages that follow. Create Sequence records 

for baseline and all anticipated courses (or cycles). For testing purposes, you may want to setup 

another ACESWin subdirectory. The data structure is stored in IDFORM.TPS, KEYPOS.TPS, 

LABELS.TPS, LENGTH.TPS, TYPEFILE.TPS, and LIST.TPS. These files may be copied into the 

testing Data directory from the development Data directory. The PA.TPS (Protocol Abstract) and 

SEQUENCE.TPS files should also be copied when they are altered. Note that you MUST keep a copy 

of the Sequence file with no test patients. 

• If your structure needs to be distributed to other sites, choose the MakeDisk option in the Startup 

submenu of the File menu. 

 

Setting up studies with non-standard forms may require the implementation of each of the below steps. If a 

new study utilizes existing forms, then steps 2, 5 and possibly 11 may be all that is necessary. 

 

1. Database Structure Details 

2. Adding Protocol Abstract information 

3. Selecting which forms and form identifiers to use 

4. The Exception file 

5. Choosing what forms should be completed for each protocol and course 

6. Defining field labels and edit checks 

7. Special picklist codes 

8. Editing field types 

9. Assigning field lengths 

10. Modifying the Form Display 

11. Defining Protocol Specific Lab Forms 

 

 

DATABASE STRUCTURE DETAILS 
 

If designing a study that uses completely new files, the following requirements must be met: 

 

• The CI file must be included in the database with at least the fields specified below. 
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• The EN file must be included in the database with at least the fields specified below ONLY if lab files 

will be present in the database that use labcodes. 

• The fixed elements of the key structure are the Form ID and the Protocol number. All patient specific 

forms must have the patient identifier in the Key 4 slot. 

• Forms containing a memo field must conform precisely to the structure of PH. 

• Define no new forms using the Form IDs BS, CA, CI, CM, DA, DT, EC, EN, EX, LA, LS, LX, NR, 

PE, PR, PS, PT, SH, SS, TX, UL, XT. These forms may be carefully modified if a protocol number is 

assigned to them and the restrictions listed below are adhered to. The Form ID NR cannot be used at 

all. 

• Creating a protocol specific form means creating all elements of the structure with a protocol number. 

Thus, you would need a protocol specific Labels record, a protocol specific Typefile record, and 

protocol specific Length records for each field. (The two exceptions to this are the EX and LX protocol 

specific forms, which do not need a protocol specific Typefile record defined.) Additionally, if the 

form is a lab, using the labcode facility, then you must create protocol specific labcodes. NOTE that 

protocol specific labcodes will ONLY work with protocol specific lab forms.  

• If you choose to delete a key field from a custom designed form, you need to set its type to “None” in 

the Typefile record before removing it from the Labels file record. 

• The key fields have the following length and type limitations: 

Field Length Types 

Key 4 12 string 

Key 5 33 integer, string, date, character 

Key 6 33 integer, string, date, time 

Key 7 8 integer, string, date, time, character 

Key 8 8 integer, string, date 

Key 9 5 integer, time 

 

If designing a study that uses some or all elements of the standard database, the fields 

listed below must remain in the order specified. The safest policy to adhere to when using 

these standard forms, is to use them only when adding new fields to the end of the 

existing form. If you wish to delete fields or add new fields in the middle of the form, 

please create a new form (a protocol specific version of an existing form is fine). Under 

all circumstances, forms with the below IDs, whether protocol specific or not, must 

have the below listed fields in the positions specified. 
 

Form: EN 

 

Sex  Non-key field 1 

Birthdate  Non-key field 4 

Registration date Non-key field 5 

Age  Non-key field 6 

Weight  Non-key field 7 

Weight Units Non-key field 8 

Height  Non-key field 9 

Height Units  Non-key field 10 

Filter Group  Non-key field 11 
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Form: CI 

 

Weight  Non-key field 3 

Weight Units Non-key field 4 

Height  Non-key field 5 

Height Units  Non-key field 6 

 

Form: CI & CA 

 

Startdate  key 5 

 

Forms: EX & LX 

 

Panel   Key 7 

 

Forms: All labs with a labcode 

 

Labdate  Key 5 

SiteID for Labcode Non-key field 1 

Labcode  Non-key field 2 

Significant?  Non-key fields 4,6,8,... 

 

Form: TX 

 

Course Date  Key 5 

 

Form: LA 

 

FollowDate  Key 5 

 

Form: BS 

 

Onset Date  Key 5 

 

Form: PE 

 

Non-key fields 1,4,7,10,13,16,19,22,25,28,31 provide program control. 

 

Forms: TX, BS, & LA 

 

Toxicity  Key 6 

CDUS Tox Type Code Non-key field 1 

 

Form: DT 

 

Toxicity  Key 5 

CDUS Tox Type Code Non-key field 1 

 

Form: EC 

 

Checklist Number Non-key field 1 

Checklist questions Non-key fields 2 through 41 

Eligible?  Non-key field 42 

Note that the picklist for the second non-key field is used for all other fields except Patient, Checklist 

number, Patient Eligible?, Why Not?, and Waiver number. If additional fields are added, this picklist (if 

any) will be applied to them. 
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Forms: CM, PT, PR, PS 

 

All key fields 

 

Form: PH 

 

All fields 

 

Form: UL 

 

Value Type  Non-key field 4 

Numeric Value Non-key field 5 

Literal Value  Non-key field 6 

Literal Continued Non-key field 7 

 

Form:  DA 

This field may be changed without any consequences. It is primed from the previous DA record on inserts 

after the first insert. This special quality is lost if its name is changed or if it is moved to a different position 

in the file structure. 

 

Lot Number  Non-key field 1 
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ENTERING A PROTOCOL ABSTRACT 
 

To enter your own Protocol Abstract information, select the “Edit” menu and the “Protocol Abstract” 

option. Once in the Browse screen, click the “Insert” button to add a new record. In order to enter data for a 

particular protocol, a record must exist in the Protocol Abstract file that corresponds to the desired protocol 

identifier. In addition to the protocol identifier, there are various other fields available for entry. In 

particular, you may enter one set of eligibility questions for each protocol and version (if there are 

amendments to the original protocol). If a Protocol Abstract record is flagged for deletion, clinical data may 

not be entered. A sample browse window is shown below: 

 

 

 
 

By double clicking on a particular record or clicking the Change button if the record of interest is already 

highlighted, the Update window is displayed. The General Tab is presented first. Of the many fields on this 

first screen, the Toxicity Criteria field is of particular importance. This field specifies which CTC 

dictionary will be used during toxicity lookups and comes preloaded in CTMS studies. For other studies, 

you may choose a dictionary from the drop down list. Each dictionary corresponds to a subdirectory of the 

Data directory.  
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As a new feature in version 4.17 (and higher), you may generate protocol specific picklists by clicking the 

“Initialize Protocol Picklists” button. This button processes through all general picklists looking for those 

that are modifiable during data entry. If a picklist can be added to on the fly, the new entries are invariably 

appropriate only for the study at hand. Clicking the “Initialize Protocol Picklists” button creates new 

picklists that are specific to the protocol opened for editting. This is strongly recommended. Any entries on 

the existing picklists of the form value=meaning (for example in the Drug Administration picklist for the 

Route field: IA=Intra-arterial) will be transferred over to the new protocol specific picklist. Other entries 

will not be transferred so as to not have inappropriate entries on these new protocol specific lists. When the 

Initialize Protocol Picklists button is clicked, a process progress window appears. When it is complete, the 

Initialize Protocol Picklist button is thereafter disabled. If you open a protocol record and find the Initialize 

Protocol Picklist button disabled, that means the protocol specific picklists have previously been created. 

 

After protocol specific picklists are created, you can edit them by clicking the Edit Protocol Picklists 

button, resulting in a window similar to the following: 
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You may insert new protocol specific picklists, update existing lists, and delete lists no longer needed. 

 

If you update one of these existing records (by double clicking or using the Change button), a window like 

the following will appear: 

 

 
 

Make sure to keep the ‘+’ in the front of the picklist to maintain the user modifiable nature of the list. Note 

that some of these picklist records will not come up with only a plus symbol. For instance, the Route 

picklist is pre-loaded with typical values, as well as being user modifiable to allow the user to add 

additional routes: 
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It is best to add new entries at the end of the list. 

 

After closing windows related to these protocol specific picklists, the protocol abstract form window will 

still be open. To enter eligibility questions in the protocol abstract, click on the tab labelled “Eligibility 

Questions 1 – 12.” Enter each question and the corresponding correct answer (Y or N), as shown below: 
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SPECIFYING FORM IDENTIFIERS AND NAMES 
 

From the “File” menu, select the “Startup” option, followed by the “Edit Form ID File” procedure. This 

will allow you to enter an identifier and associated long name for each electronic form to be used for a 

study. Each form should also be flagged in terms of whether Labcode field logic will need to be used, i.e. 

only for forms where we need to collect information associating the lab results with the lab that processed 

them. Below is a sample browse and an associated BC (blood chemistry) FormID entry form. Note that the 

“Menu#” associated with each Form ID will be assigned in alphabetical order after each new form is first 

selected for entry from the “Database” menu item. 
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THE EXCEPTION FILE 
 

The Except.tps file, stored in the Data directory, regulates in certain ways the alteration of the data 

structure. A record in the Except file has two fields; FormID and Status. The different possible values for 

Status are Unrestricted, Offlimits, Partial restriction, and Locked. Forms entered in the Except file may be 

thus regulated:  

 

• The Unrestricted classification performs no regulation on the form’s structure.  

• The Offlimits classification prevents that form ID from being added to the idform.tps, essentially 

preventing the creation of a form with that ID.  

• The Locked classification prevents any modification of a 00000000 default form’s structure.  

• The Partial restriction classification only allows new fields to be added to the end of a 00000000 

default form, questions every delete of a field (but does not prevent deletion) in a 00000000 default 

form, warns about changing the type of any field in a 00000000 default form, and warns about 

changing the length of any field in a 00000000 default form.  

 

DB privilege is required to modify the Except file. To access the Except file, choose Edit Exception File 

from the Startup submenu of the File menu: 

 

 
 

The update window will look similar to: 
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In the above example, the form ID NR is classified as Offlimits. The ID NR is used by ACESWin when 

Lab Normal Ranges are extracted, thus a clinical form using NR as an ID must not be created. 

 

Changes to the Except file should be made thoughtfully, and should not be avoided if all ramifications have 

been considered. 
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CHOOSE FORMS REQUIRED FOR EACH COURSE 

 
The sequence bar provides an online reminder regarding which electronic forms need to be completed for 

each course or cycle. This is strictly a user guide; it does not prevent the completion of forms not listed for 

a given course. However, ACESWin requires that there be Sequence records for each course that a patient 

may be involved with. Access to the Sequence file requires the DB privilege. If you are expecting to 

receive a protocol startup disk, but wish to start your data entry, you should enter a Sequence record for 

course 0 (baseline) and course 1. The course 1 record can then be copied for all other possible courses. 

Details on the contents of these records are listed at the end of this section.  

 

To insert data into the Sequence file, select the "Startup" option from the "File" menu. Then, select the 

“Edit Sequence” procedure. This Sequence file needs to have information added for each protocol, 

including which forms need to be filled out for each course, and (optionally) associated notes. The browse 

window displays the Protocol and Course fields. First, select a protocol from the Protocol Abstract file by 

clicking on the Select Protocol button. Then, select a record to edit or copy, or click “Insert” to add a new 

record. Sample screens are displayed below: 
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Once in the entry form, you may modify a record’s contents, or add notes related to each electronic case 

report form. WARNING:  Form notes may be altered throughout a study. However, the form 

sequence may only be altered during the initial record insert. Since the Sequence file is driven by the 

protocol, course and patient numbers, forms that are NOT patient oriented should not be included in the 

sequence of forms to be filled out. For example, the DT (Dose Limiting Toxicities) and EP (End Points) 

forms as they are currently defined should not be included in a Sequence record.  
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When a patient is added to the Patient file, the Sequence file automatically creates a record for that patient 

for each course. These automatically generated Sequence records cannot be deleted. This is why it is 

important to always keep a copy of the Sequence file separate from test or live clinical data if you are 

running an in-house study not connected to Theradex®. This Sequence file can be updated throughout the 

study to include new form notes or whole new courses. Using the MakeDisk facility, the updated Sequence 

file can be correctly extracted. The extracted Sequence file is then loaded into the live database ACESWin 

using the Load Startup Data option in the Startup submenu of the File menu. This loading process will 

correctly insert new Sequence records for existing patients.  

 

The sample entry form below shows that for protocol 111-1111 and course 0, we expect information for the 

PT (prior therapy), PR (prior radiation), PS (prior surgery), HM (hematology), BC (blood chemistry), PL 

(physical labs), and US (urinalysis) forms. 

 

 
 
For CTMS studies, the course 0 (baseline) Sequence record has the following form IDs in the following 

order: EN, EC, TF, PT, PR, PS, CM, MH, PE, BS, LS, XT, PH, IE, BC, US, EX, LX, HM, LL, OU, PL, 

RC, RF, BM, SC, SR, UL, UX, IP. All other courses, starting with course 1 have the following form IDs in 

this order: CI, DA, CM, PE, LS, XT, TX, PH, BC, US, BM, HM, LL, OU, PL, RC, RF, SC, SR, UL, CA, 

FO, FP, IP, DS, EX, LX, PK, IE, MH. 

 
 

DEFINE LABELS AND EDIT CHECKS 
 

From the “File” menu, select the “Startup” option, followed by the “Edit Field Labels and Lists of 

Acceptable Data” procedure. You can insert and change information related to field names and associated 

edit checks for these fields. Records stamped with the 00000000 protocol cannot be deleted. If you wish to 

add a form for a particular study, use the study's protocol number instead of 00000000. This may be deleted 

later if desired. If you wish to add a form that you intend on using for several studies, use the generic, 

default protocol 00000000. You must run the “Delete Lists of Acceptable Data” procedure , available in the 

Startup submenu of the File menu, to delete edit checks. You will need to identify key fields (those field 

values which serve to uniquely identify a record) and non-key fields. Each field may have an edit check 
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designated as “R” (range of values) or “E”  (list of acceptable entries, otherwise known as a picklist). 

Ranges are entered into “Min” and “Max” screen prompts, which appear if a field is selected that has an 

“R” edit check type. Fields with an “E” edit check type use the notation “R=Radiation,C=Chemotherapy”, 

for example, to enter the set of valid codes. There must be no spaces in this list, so you may want to use the 

underscore character to separate words (e.g. 1=No,2=Life_Threatening). The equal sign and explanation 

are strictly optional, so Y,N,X=Unknown is a perfectly good picklist with three options. Pressing the F10 

function key will display the picklist for the current field, if one exists. See “Special Picklist Codes” for 

more picklist details. 

 

If a particular study will use the same (or almost the same) form structure, but different edit checks, click 

on the Change button for the labels record having the identical structure. Next, change the Protocol from its 

current setting (usually 00000000) to the protocol number for the new study. Keep the labels the same and 

specify the edit checks required. Note that during data entry, ACES® will apply any edit checks from 

the generic 00000000 form to fields in a protocol specific form if no protocol specific edit checks have 

been defined. In order for these “backup” edit checks to work properly, the field name in the new 

protocol specific form must be identical to the corresponding field in the generic 00000000 form. 

NOTE that during data entry, “backup” picklists will not cause the field prompt to be underlined, 

yet the picklist will still be operational. If you do not want the backup edit checks to affect your new 

protocol specific form, you must either define all new edit checks for each field that has a 

corresponding edit check in the generic 00000000 form, or alter the names of such fields in your 

form. When you click on the OK button, a new Labels record will be inserted, leaving the original one 

intact. It will not be necessary to add Types for these fields, but you will need to add field lengths. See 

"Assigning Field Lengths". Also see Protocol Specific picklists in the Protocol Abstract section. 

 

To insert a new record, click the Insert button and enter the key fields. After key field entry is complete, re-

enter the record in “Change” mode to add the non-key field labels and all desired edit checks. Note that for 

files capturing laboratory information linked to the lab normals file (i.e. the “Uses Labcode?” flag in the 

FormID record is equal to “Y”), simple ranges are not used for edit checking since multiples of the normal 

range values are automatically used instead. 

 

Certain files in the standard database definition, EX and LX, are designed to allow multiple sets of field 

labels based on the protocol identifier and a code field called “panel”. In these cases, depending on which 

protocol and panel number is selected, different field labels will appear on the associated entry forms and 

reports. If you decide to add a new EX or LX file definition, please refer to an existing EX or LX file so 

that the correct fields are defined. In all study installations, at least one dummy EX and LX form has been 

included for reference purposes. In particular, the key fields for these files must be:  FormID, Protocol, 

Patient, Date, Time, and Panel. In addition, for the EX file only, the first two non-key fields must be 

“SiteID for Labcode” (an eight character string), followed by a 4 digit integer “Labcode” field. All non-key 

fields after these must be pairs of fields with the first being data type “Real” and the second being a one 

character associated “Significant?” flag, for the EX file. For the LX file, all non-key fields must be defined 

with a “String” data type. See “Special EX and LX considerations” for more details. 

 

Several examples of various forms and associated edit checks are presented below. 
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This is a sample “LL” (literal lab) form with its associated key fields and edit check information. 

 

 
 

 

This is a “DA” (Drug Administration) form, with its associated key fields and edit checks, followed by a 

window containing the related non-key fields and edit check information. 
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This is a “TX” (toxicity, or adverse events) form with its associated key and non-key fields and related edit 

check information. 
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SPECIAL PICKLIST CODES 
 

If a picklist ends with “,FREE!” then free text entry is allowed. This means that the picklist is just a 

guideline; it does not restrict entry at all. Note that FREE! must be the last entry in the picklist. For 

example, the picklist for the field Schedule in the DA form is 

QD,BID,TID,QID,QWK,PRN,q4h,q6h,q8h,q12h,FREE!. If a picklist begins with “+,” then users may add 

new entries to the picklist during data entry. Finally, if a picklist begins with “!REQ,” then the associated 

field is required; an entry must be chosen. Such a picklist might look like 

!REQ,1=Mild,2=Moderate,3=Severe,4=Life_Threatening,5=Fatal. Note that FREE! will cancel the effect 

of !REQ if both are included in a picklist. 
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DELETE LISTS OF EDIT CHECKS 

 
From the “File” menu, select the “Startup” option, followed by the “Delete Lists of Acceptable Data” 

procedure. Use this procedure to delete edit check information. Note that this information is added and 

updated through use of the “Edit Field Labels and Lists of Acceptable Data” option, although the edit 

checks themselves are physically located in this separate “List” file. In general it will not be necessary to 

delete edit checks, but if needed, then this “Delete Lists of Acceptable Data” procedure must be used. If an 

edit check is of the "E" (list of acceptable entries) variety, it appears as a "footnote" in the datalisting 

report. If a field is removed from the structure of a form, but an associated "E" type edit check is not 

deleted in the "Delete Lists of Acceptable Data," it will still appear in the datalisting footnote. Additionally, 

if an edit check is "blanked out" while editing a Labels form, the edit check is blanked out but not deleted 

and will continue to affect data entry in perhaps unexpected ways.  

 

After deleting a picklist edit check (type E), it is important to bring up the associated Labels record 

in “Edit Field Labels and Lists of Acceptable Data”. Once the record is displayed, click on the OK 

button. This removes the underline from the field label, indicating that no picklist is available. For 

example, suppose a picklist for a field in the DA form is deleted. To remove the underline indicating the 

presence of this picklist, a user would need to update the DA record in the Labels file.  

 

 A sample window appears below: 
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EDIT FIELD TYPES 

 
From the “File” menu, select the “Startup” option, followed by the “Edit Field Types” procedure to set 

these attributes for each form. Each field for every form used in a study must be assigned a data type. The 

choices are: “S” (string), “D” (date), “T” (time), “C” (character), “I” (integer), “R” (real), “X” (text), or 

“M” (memo). To change an existing record, highlight the target Form ID and click the Change button. You 

may also insert or delete these “Typefile” records. A sample browse window with the “PK” 

(pharmacokinetics) form highlighted is shown below: 
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Lab forms making use of the labcode (Normal ranges) facility must have the "Uses Labcode" checkbox 

checked. The first entry screen contains the key fields for the selected form as follows: 

 

 
 

After assigning, or changing, the field types for the key fields, continue to the next screen on the second tab 

to edit the non-key field types. Only one memo field is allowed, and it must be the first and only non-key 

field. A non-key field longer than one character that has an associated picklist should be defined as a 

String. A sample of a non-key entry form for the “PK” form is shown below: 

 
For related information on EX and LX, see "Multiple Lab/Literal Extra Forms In A Given Protocol." 
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EDIT FIELD LENGTHS 

 
From the “File” menu, select the “Startup” option, followed by the “Edit Length File” procedure to set 

these attributes for each form. Allowable field lengths for the following types are described below: 

 

String 1 – 24 

Date 8 

Time 4 

Char 1 

Integer 1 – 12  

Real 4 – 10 

Text 1 – 64 

Memo 1 – 1024 

 

Floating Point Format (for Real type fields): 

Length Format  

------ ------ 

4 x.xx 

5 xx.xx 

6 xxx.xx 

7 xxxx.xx 

8 xxxx.xxx 

9 xxxxx.xxx 

10 xxxxx.xxxx

 

A sample “Browse the Length File” window is shown below: 

 

 
 

Clicking on the "Update From Labels" button will start a process that cycles through the entire Labels file, 

looking for labels that are not already present in the Length file. Records are added to the Length file for 

each of these "new" labels. After the process is complete, search through the browse listing for any records 

having 0 in the length column. Update these with the appropriate field length. Additionally or as an 

alternative to manual searching, click on the Consistency Check button. All Length file records will be 

analyzed by comparing the field’s type with its length. A report similar to the one below may be displayed. 
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Fields with length 0 will be listed, as well as fields whose lengths violate the limits set for their particular 

type (see top of page for type length limits). This report may be sent to your printer. Whenever you finish 

designing a new form, running this consistency report is a good idea. 

 

The entry form for the Length browse box would be similar to the following window for the “DA” (drug 

administration) form. 
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MODIFYING THE FORM DISPLAY 
 

From the "File" menu, select the "Startup..." submenu, then choose "Modify Form Display." A sample 

"Choose Form Below To Modify Screen Display Of Fields" window is shown below: 

 

 
You may move any of the field boxes anywhere you want on the tab. To move a field, place your mouse on 

the field and press the "A" key (for "activate") on your keyboard. The field will now follow your mouse, if 

you move it slowly. Though it is not required, it helps to keep your mouse's left button held down. When 

the field is in position, press the "F" key (freeze). The default movement amount is 1 screen unit. To 

increase the amount of space covered, press the "B" key ("big" movement). This will speed up the 

movement process, but will not allow for precise placement. Press the "L" key ("little" movement) for 

precision placement. Note the guidelines separating the prompt text from the actual field; lining these 

guidelines up will left justify the fields. If you move your mouse too fast and "lose" the field, simply move 

the mouse back onto the field. Once the "A" key is pressed, all fields are activated. Thus, be careful not to 

drag one field onto another; they will both move with the mouse. If this happens, press the "F" key to freeze 

the screen, then carefully place your mouse on a part of one field that is longer than the other field. Press 

"A" to activate and move the overlapping field away from the other. If the fields are the same length, it is 

possible to separate the fields by careful maneuvering. 

 

Note that the tab is much larger than the window it is displayed in. There are vertical lines that should give 

you an idea of the boundaries of each "page." To move a field from one page to another, move it to the 

edge of the page, then click on the scroll bar below to scroll the tab in the direction of interest. Then 

continue to move the field. Below is a sample of the "BC" form: 
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Click OK when you are happy with the screen display. Be very careful about using the Reset button. It 

currently resets the fields to a very spread out, block style. Clicking on Reset is not reversible; it resets the 

form and closes the window. 
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DEFINING PROTOCOL SPECIFIC LAB FORMS 
 

These instructions do not apply to the EX (Lab Extra) form. See “SPECIAL EX AND LX 

CONSIDERATIONS”. 

 

Adding a Protocol specific Lab form based on a current form 

 

1. In the Labels Browse, update the current form that will serve as the basis for the protocol specific 

form. 

2. Change the protocol number field to the target protocol number. 

3. Update the non-key fields as desired, but with the following guidelines in mind: 

• If current tests will remain as is, add new tests at the end. This preserves the integrity of the units, 

leeway percentages, display order, conversion factors, and labcode ranges for the existing tests. 

Remember, the tabbing order for lab tests can be altered by choosing Lab Units in the Edit menu. 

• Fields may be deleted, but associated units, leeway percentages, display order, conversion factors, 

and labcode ranges will not likewise be deleted. All of these values will have to be adjusted 

accordingly. 

• Each new test MUST have a Significant? field inserted after it. This field label must be spelled and 

capitalized exactly as shown above. 

• If an existing test is to be replaced, remember to update the units, leeway percentages, display 

order, conversion factors, and labcode ranges. 

4. Click on OK to save the record. Note that since the protocol number was changed (a key field for the 

Labels file), a new record was added, preserving the original record. 

5. In the Typefile Browse (choose Edit Field Types in the Startup submenu of the File menu), update the 

record associated with the original Labels form. 

6. Change the protocol number field to the target protocol number. 

7. Click on the All Other Fields tab and note that the lab tests as defined in the new Labels record are 

now displayed here. Define field types for all untyped fields. 

8. Click OK and note that again a record has been added instead of updated. 

9. In the Length Browse, click on the Update from Labels button. After the process completes, there will 

be a record in the Length file for each record in the Labels file (existing Length records are NOT 

updated). Find the section of the list with the new protocol specific records. 

10. Update each record with the appropriate length. Use the Length records from the original Label form 

as a guide. The lab tests should in general be 9 characters, the lab code should be 4, the SiteID for the 

Labcode should be 8, the Lab date should be 8, the Lab time should be 4, the Patient field should be 

12, and the Significant? field should be 1. 

11. Choose Lab Units in the Edit menu. Double click on the new protocol specific form record displayed 

in the browse. 

12. New tests added at the end of the existing tests will NOT be marked with a green check. Click on each 

of these tests to specify the set of allowable units. The first unit will be used as the default and its 

conversion factor should be 1. The display order and leeway percentage may be set here as well. If any 

existing tests were changed (deleted, moved due to insertion, or replaced), the unit records of all tests 

after the changed tests should be checked, as well as those of the changed tests. When complete, click 

on the OK button to save the record. The program guards against duplicate order numbers. 

13. Choose Labcodes (Normals) in the Edit menu. Either enter a new labcode record for the protocol 

specific form, specifying the protocol number in the labcode record itself, or follow the below 

instructions for modifying an existing labcode. 

• Copy an existing labcode record. Keep the existing protocol in the protocol field. Enter an 

appropriate Sex, then click OK. 

• Update the record that has just been copied. Now, enter the protocol in the protocol field and any 

other changes to the key fields. Select the browse box of the different lab tests to display the new 

labels from the protocol specific form. Make no changes to the lab test records, just click on OK to 

save the record. 

• Once again, update the record, this time making necessary changes and additions to the lab test 

records within the labcode record. 
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CONFIGURATION OPTIONS 

 
The “Configuration Options” selection from the “File” menu allows you to set function keys to map to 

protocol numbers and the 4 digit year, to verify the correctness of the data extraction and archive 

directories, and choose several other settings connected to program operation and data transmission. In the 

example below, we have set the F5 function key to correspond to the protocol number 111-1111. This 

means that when we need to enter a protocol number anywhere in the ACES® system, we can press the F5 

key instead of entering the 111-1111 protocol number. Similarly, whenever we need to enter a 2004 year, 

we can press the F9 function key since 2004 has been mapped to it.  
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A sample entry screen for these different configuration options is shown below. For the paths, you’ll need 

to enter, at a minimum, the disk letter. In the window below, we have designated the “D” drive as our 

default disk drive, with the associated file paths. Another common configuration is to designate “A” as the 

default drive, if you plan to use diskettes for these functions. In certain functions like loading startup data, 

if “A” is specified, ACESWin ignores any path that you might have entered in the below configuration file 

entry screen. The Data Center path is used when you need to load an ALZ compressed file received from 

some other ACESWin site. In the Data Center Extract File Format box, you can switch the extraction file 

format between ALZ, the new compressed and encrypted email ready format, and XTR, the traditional non-

encrypted ASCII file format. Note that the ALZ format produces one file containing data from all extracted 

forms, while the XTR format produces one ASCII file for each form from which data was extracted. When 

the ALZ format is chosen, the Transfer to Data Center path may not be altered from the default. The 

ACESLink Account Number is stored in the ALZ file. Theradex® uses this to determine where to store 

your ALZ file when it arrives. Other data centers could also use this account number field to sort ALZ files 

coming in from multiple sites. The Security Key must be filled in if the ALZ file format is chosen for the 

Data Center Extract. The key may contain spaces and may be up to 60 characters. Please make this phrase 

as long and obscure as possible. It is used by ACESWin to protect the secrecy of the data stored in the ALZ 

file. This is important because these ALZ files will be sent over the internet as email attachments, and 

could potentially be intercepted.  

 

IF YOU MOVE YOUR ACES® INSTALLATION: After moving the ACESWin folder and its 

contents from one location to another, you should update the Directory Paths in this window to 

reflect the new location. 
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 The Browse Mode setting changes the type and amount of data displayed in each clinical form’s browse 

window. Filtering by protocol and patient may result in longer window opening times depending on your 

computer and the installation configuration. The Non-activity re-login time replaces the previously 

implemented auto-logout feature. After the set period of non-activity, a window is displayed, covering your 

entire display. This window requires you to log back in. If you click on Cancel, ACES® will shut down. A 

sample re-login window is shown at the end of this section. 

 

Clicking on the Internet settings tab takes you to page two. The first field should contain the SMTP IP 

address for your data center, by default Theradex® in the United States. This enables ACESWin
 
to send 

data directly to your data center via your internet connection. If Theradex® is your data center and you 

need not send data to other sites, then please do not change the default value in this field. If you intend to 

send data to Theradex® and other sites, you must replace the default value with your organization’s SMTP 

IP address. Finally, correctly classify the SMTP IP address as either belonging to the Data Center 

(Theradex® in most cases) or your organization. 

 

 
 

Some institutions have an enhanced SMTP server (ESMTP) with user authentication required. If that is true 

for your institution, then you will need to check with your Internet security staff to confirm your user ID 

and password, then set the ESMTP Password and User ID fields by clicking on the Additional 

Configuration Settings button at the bottom of the main form window. The Additional Configuration 

Parameters window will be displayed. The Password Expiration parameter can also be set in this window. 
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The value for the Password Expiration is the number of days between password changes. By default, it is 

set to 60 days. You may change it to whatever positive value suits you and your institution, but note that it 

is wise to periodically change your password. 

 

Double click each additional configuration parameter (or click on the Change button) to set its value: 

 

 
 

Note that the ESMTP values must only be set if your email server requires authentication. 

 

Sample re-login window: 
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REPORTS 

 
To print reports of your ACES® for Windows data, select the “Print Reports” option from the “File” menu. 

The first window will allow you to enter values to filter the data that will subsequently appear on reports. 

You can select data by protocol, patient, course, start date (this refers to the last changed date), and form. 

You may also select the report orientation, the paper size, whether to direct the report to a file, and the 

protocol type. After completing this screen, you can select a report from the list of available reports on the 

subsequent screen. A filter screen would be similar to the following: 

 

 
 

Clicking on the Select Report button brings up the Choose Report window: 
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The Data Listing report contains the data actually entered in each form. If you have chosen not print data 

from all forms, you will be given the opportunity to choose which forms you wish to print from after 

clicking on this button. 

 

The Case Report Forms report contains transformed data such that any codes have been replaced with their 

meanings. This report is much more readable than the Data Listing report. You will have the opportunity to 

choose whether or not you want a signature line printed on each page. This report is organized by patient, 

each patient having a cover page. Again, if you have chosen not to print data from all forms, you will be 

given the chance to choose which forms you wish to print. 

 

The Current Audit Trail Listing report provides an audit trail print out of everything that has happened in 

your database since the conversion from version 4.08 to 4.11. Each record may be printed many times – 

each time a record is changed, extracted, loaded, deleted, undeleted – changed in any way, a copy of it is 

added to the Audit Trail file. This file and report provides a complete history of each record.  For everyday 

usage, this report may not be terribly useful. It is excellent for tracking a problem down during audits and 

general trouble shooting. 

 

The Previous Audit Trail Listings initially should only be one report: the audit trail from before the 4.08 – 

4.11 conversion. Eventually, you may have several directories containing previous audit trails. 

 

The Extract/Load File Structure report provides a description of the ascii file structure of the extract, load, 

and archive files (XTR, XFR, ARC). You may print all structures or a specific one. The report lists the 

order and names of the fields found in the files, as well as the field type and length. 

 

The Pick Lists report provides a listing of all pick list edit checks currently active. See the Special Picklist 

Codes section for details on special characters and codes that you may find in these picklists. 

 

The Protocol Abstract report provides a print out of the entire protocol abstract file, or a selected protocol, 

including the eligibility checklist questions. 

 

The Patient File report is a print out of the patient file. 

 

Clicking on Bounce Reports brings up a second window from which you may choose to specify a bounce 

log for printing. 
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FIXING A BAD PATIENT IDENTIFIER 

 

Choosing Fix Patient Identifier from the File menu opens up the following screen: 

 

 
 

The protocol must exist in the Protocol Abstract file, just as the old patient ID must exist in the Patient file. 

The new patient ID may or may not be present in the Patient file. Clinical data already entered for the new 

patient ID will take precedence over any data with the same key structure entered with the old patient ID. 

Clicking on the Process button will cause new records to be created with the new patient ID from the 

existing non-deleted old patient ID records for the entire database. The old patient ID records will be 

flagged for deletion. The Sequence and Patient file records will also be updated (new records will be added 

with the same data the old records had). Old patient ID sequence records will not be deleted. Click on the 

Close button to close the window when finished. 

 

 



23-October-2007 

 

 109 

 

SYNCHRONIZING THE SEQUENCE BAR 
 

The sequence bar can lose its synchronization with the data entered if course numbers of forms are changed 

during form updates, or during a data load/import. To synchronize the sequence bar with the clinical data as 

it exists in the forms, choose Synchronize Sequence Bar from the File menu. There is no harm in doing 

multiple synchronizations. 
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HELP SYSTEM 
 

The ACES® system provides hypertext help when you choose one of the commands on the  “Help” menu, 

or press the F1 function key. The text of the help system is, in general, the same as, or similar to, the 

printed documentation that comes with the software. 
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BACKING UP DATA 
 

If your ACES® is installed on a network drive, your data should be automatically backed up nightly. You 

may want to check with your computer systems department to confirm this. 

 

If your ACES® is installed on your local C: drive, it is very important to back your data up after each day 

of data entry. This may easily be accomplished by copying the crucial data files to a folder reserved for this 

use on your network. A batch file may be set up that accomplishes this, with a desktop shortcut icon 

pointing to it. After finishing your daily work in ACES®, double clicking the Backup icon would result in a 

backup of your ACES® data. Below is an example of how this may be set up. Note that the specifics will 

be different on each computer and network. 

 

First, one would need a batch file. It could be called ACESBackup.bat. In the sample below, the user has 

access to a network drive mapped to the letter M:. And three directories have been previously setup: 

m:\acesbackup, m:\acesbackup\data, and m:\acesbackup\atrl. This precise directory structure does not need 

to be adhered to – these directories could be buried within other directories. 

 

@echo off 

copy c:\aceswin\std4\data\*.* m:\acesbackup\data 

copy c:\aceswin\std4\atrl\*.* m:\acesbackup\atrl 

copy c:\aceswin\*.tps m:\acesbackup 

 

 

After creating this batch file, save it at the root of your C: drive. Next, you need to setup a shortcut icon on 

your desktop. The instructions below work in Windows 98. The process would be quite similar in other 

Windows operating systems. 

 

1. Right click on any open space of your desktop. 

2. Put mouse pointer on "New", then choose "Shortcut" from submenu. 

3. Type C:\ACESBACKUP.BAT in Command line field. Click Next. 

4. Type ACES Backup in Name for Shortcut field. Click Next. 

5. Choose your favorite icon, then click Finish. 

6. Right click on your new icon, then choose Properties. 

7. Click on Program tab, then click on the "Close on Exit" checkbox, placing a check in it. 

8. Click the OK button at the bottom of the Properties window to close it. 

 

Regardless of how one sets up the tools for backing up data, the important thing is to DO THE BACKUP! 

If you don’t, some of your data may be lost someday. Every computer is a machine which will break down 

eventually. 
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DATE FORMATS 

 
All dates must be entered using the international date format, i.e. DD MTH YYYY where DD is the two 

digit day number, MTH is the 3 character month abbreviation (JAN, FEB, MAR, APR, MAY, JUN, JUL, 

AUG, SEP, OCT, NOV, DEC), and YYYY is the four digit year. Certain date fields will allow coded 

values. Examples are as follows (a “-“ means to enter a space):  

 

Code Meaning  Entered   Displayed  Printed 

 

 “Not Entered”  -- NOT 0000       NOT 0000  00 NOT 0000 

 

“Unknown”  --  UNK        UNK 0000  00 UNK 0000 

 (allowed in most non-key date fields) 

 

“Unknown Day/Mth” --  UNK YYYY      UNK YYYY     UNK YYYY 

 (only allowed in PT, PR, PS, TX, BS, and CM files) 

 

“Ongoing”  -- ONG        ONG 0000  00 ONG 0000 

 (only allowed in CM, TX, and BS files) 

 

“Not Applicable”  -- NA        NA    0000  00 NA    0000 

 

“Not Legible”  -- NL        NL    0000  00 NL    0000 

 

Note that certain dates are designed to accept incomplete information. For example, the day of a prior 

surgical procedure may not be known. 

 

A “hot key” can be programmed to the current year. If entered in the Configuration Options menu, you can 

press the F9 function key to insert the current year. 
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MISSING AND SPECIAL CODES FOR ENTERED DATA  
 

ACES® contains several sets of special codes that can be used to indicate why a certain field of data has 

missing or incomplete information. There are four categories of field types that have their own set of these 

codes; dates, times, literals, and numeric fields. The description of these codes is as follows (a “-“ means to 

enter a space): 

 

Dates: 

 

Code Meaning  Entered   Displayed  Printed 

 

 “Not Entered”  -- NOT 0000       NOT 0000  00 NOT 0000 

 

“Unknown”  --  UNK        UNK 0000  00 UNK 0000 

 (allowed in most non-key date fields) 

 

“Unknown Day/Mth” -- UNK YYYY      UNK YYYY    UNK YYYY 

 (only allowed in PT, PR, PS, TX, BS, and CM files) 

 

“Ongoing”  -- ONG        ONG 0000  00 ONG 0000 

 (only allowed in CM, BS, and TX files) 

 

“Not Applicable”  -- NA        NA    0000  00 NA    0000 

 

“Not Legible”  -- NL        NL    0000  00 NL    0000 

 

 

Times: 

 

Code Meaning  Entered   Displayed  Printed 

 

“Not Entered”  -        :       : 

“Unknown”  0     0:00   00:00 

“Not Applicable”  NA   NA:   NA: 

“Not Legible”  NL   NL:   NL: 

 

 

 

Literals: 

 

Code Meaning  Entered   Displayed  Printed 

 

“Not Entered”  -    

“Unknown”  @   @   Unknown 

“Not Done”  !   !   Not Done 

“Not Applicable”  #   #   Not Applicable 

“Not Legible”  %   %   Not Legible 

 

 

Note: For literal fields only if a value was previously entered into a field, and then spaced over to go back 

to the “Not Entered” value, then an “*” symbol will appear on the screen.  
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Numeric Fields: 

 

Code Meaning  Entered   Displayed  Printed 

 

“Not Entered”  -2   -2    

“Unknown”  -4   -4   Unknown 

“Not Done”  -5   -5   Not Done 

“Not Applicable”  -1   -1   Not Applicable 

“Not Legible”  -3   -3   Not Legible 

 

 

SEQUENCE BAR 

 
In order to keep track of which forms need to be completed for each patient and course, the ACES® 

program maintains a Sequence Bar. This is strictly a user guide; it does not prevent the completion of forms 

not listed for a given course. A vertical bar appears on the right side of the screen after protocol, patient, 

and course values have been selected from the “Set Protocol/Patient/Course” menu item. This bar consists 

of three columns of data. The first column shows the two character abbreviation for each form that needs to 

be completed for the selected patient and course. The second and third columns denote the status of that 

form. The second column is either blank (no entry has been done for the associated form) or has an “S” 

(entry has been started for the form). The third column is either blank (no entry has been done for the 

corresponding form), has an “I” (entry has been started, but is incomplete), or has a “C” (entry is 

complete). The values in the status columns are automatically set by ACES®, EXCEPT for the “C” status 

flag. The data manager must decide whether entry for that patient, course, and form is completed. If so, the 

“I” box in the third column is clicked, which changes it to a “C”. Note that this is reversible (by simply 

clicking). Once all forms for a particular patient and course are flagged “completed”, then when the patient 

and course are initially selected, the overall status indicator will also change to a “C” flag. This process will 

significantly aid the user in keeping track of how much entry remains to be done for a particular patient. 

Note that the sequence bar may be moved around the screen (as any window may) by pressing and 

dragging the shaded “title” top portion of the bar. A sample Sequence Bar is shown below: 
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In this example, the PT (prior therapy) and PR (prior radiation) forms are complete, the PS (prior surgery), 

HM (hematology), and BC (blood chemistry) forms are in progress, and the PL (physical labs) and US 

(urinalysis) forms have no entry as yet for protocol 111-1111, patient 002, and course 0. 
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MAKEDISK 

 
If you’d like to act as a central data center, and create your own Protocol and Lab Startup diskettes, you’ll 

need to choose “Makedisk” at the bottom of the Startup… submenu of the File menu. The Protocol Startup 

disks can contain as little as protocol abstract and course sequence information, and as much as the details 

of an entirely custom defined database structure. Note that only a DB user may utilize the Makedisk option. 

Keeping the Extraction type as “ACESWin” will lead to files readable only by ACESWin. Choosing 

“Other Database” will produce ASCII files. It is usually more efficient to keep the destination as a hard 

disk, then copy the contents of the Startup directory to a floppy disk (or attach to an email message). If 

using a floppy disk, clearly mark it with the appropriate Protocol identifier(s) or labcode number(s). 

 

 
 

 

If Protocol  Abstract is selected, enter the corresponding protocol identifier, and either “Yes” or “No” to 

transfer all data. Note that you can run this extraction twice, once for your specific protocol and once for 

the generic form protocol (00000000) if you need to transfer the entire ACESWin data structure 

somewhere. Of course, all ACESWin installations will already have the standard 00000000 structure.  
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The files generated by MakeDisk are named based on the first eight characters of the protocol number 

entered in the above field. In the table below, the example protocol number of 111-1111 is used: 

 

Above listed option Files generated Explanation, if any 
Protocol Abstract 111-1111.pas 

Startmas.tps 

Startmas.tps contains the site ID 

of the MakeDisk user. 

Sequence File 111-1111.seq  

Labels File 111-1111.lbl 

111-1111.kps 

Labels are stored in the .lbl file, 

key field positions are in .kps file. 

Type File 111-1111.typ  

Length File 111-1111.len  

List File 111-1111.lis Contains picklists. 

Protocol Specific Ranges 111-1111.exv Labcode(s) for Lab Extra panels. 

Form ID File 111-1111.fid  

 

 

Warning: If any testing has been done in this directory with real or test patient data, the Sequence file will 

be corrupted and should not be used to initialize or update an actual ACES® study. If this has happened, 

exit out of ACESWin. Using the Windows Explorer or a DOS prompt, delete the files PAT.TPS and 

SEQUENCE.TPS in the Data subdirectory of the study directory you have been working in. Get back into 

ACESWin using your DB username and recreate the Sequence records for the study. Note that you will 

have to recreate the entire Sequence file, including sequence records from other studies if they were 

stored in the same directory. 
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If Lab Normals is selected, enter the associated lab code identifier.  
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AUDIT TRAIL 
 

All clinical data entered into ACES® for Windows is kept in two places, the active database and the audit 

trail database. All edits and insertions applied to the active database are posted to the audit trail database. 

The only difference between the two databases is that the audit trail uses the change date and time as part of 

each record’s key. Therefore, any time a record is added, changed, or flagged, a copy of the new version of 

that record will be added to the audit trail database, preserving a record of all prior versions. 

 

   


